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Getting Started

 

Starting Painter

 

Macintosh

 

Open the Painter 5 folder and double-click 
the Painter 5 icon.

 

Windows

 

Click the 

 

Start

 

 button and select 

 

Programs> Fractal Design> Painter

 

 5. 

 

What is in this Lesson

 

Painter has some unique features you can 
try right now. This lesson is about 
accessing items from palettes and using 
tools and effects to create a new image 
quickly. You will open a photograph and 
use Painter’s cloning features to create 
three different styles of that image. You will 
quickly master Painter’s cloning features 
to:

 

•

 

Link up source and destination images

 

•

 

Trace an image

 

•

 

Clone an image

 

•

 

AutoClone an image

 

•

 

Composite three cloned images into one.

 

You can access detailed on-line help via the 

 

Help

 

 
menu. With the Painter Help system, you can search 

 

for keywords and set bookmarks.

 

Painter’s Palettes

 

Most of Painter’s controls are organized 
into palettes. Painter opens the first time 
with its five main palettes showing—

 

Tools

 

, 

 

Controls

 

, 

 

Brushes

 

, 

 

Art Materials

 

, and the 

 

New Brushes 

 

custom palette. Some of 
Painter’s palettes have menus on them with 
additional options.

Take a moment to look at the differences 
between the five palettes.

 

•

 

The 

 

Tools

 

 palette determines your 
current activity. For example, you use this 
palette to tell Painter whether you want 
to draw, zoom in on a document, or select 
part of an image.

 

•

 

The 

 

Controls

 

 palette changes to reflect 
your selection in the 

 

Tools

 

 palette and to 
give you instant access to the selected 
tool’s main functions. For example, when 
you have selected the 

 

Brush

 

 tool, the 

 

Controls

 

 palette shows Draw Style and 

 

Size

 

, 

 

Opacity

 

 and 

 

Grain

 

 controls.

 

•

 

The 

 

Brushes

 

 palette is where you choose 
from Painter’s wealth of drawing, painting 
and image editing brushes. Brushes can 
be moved from inside the palette drawer 

 

˙
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to the drawer front. The 

 

Brush

 

, 

 

Variant

 

, 

 

Control

 

, 

 

Nozzle

 

 and 

 

Stroke

 

 menus offer 
additional options.

 

•

 

The 

 

Art Materials

 

 palette is where you 
select your art materials—from the 
basics, like a color for your pencil, to 
unusual patterns and complex color 
gradations. The subpalettes of the 

 

Art 
Materials

 

 palette are 

 

Color

 

, 

 

Paper

 

, 

 

Grad

 

 
(Gradations), 

 

Pattern

 

 and 

 

Weave

 

.

 

 

 

The 
corresponding subpalette menus offer 
additional options for each art material.

 

•

 

The 

 

Shortcut to

 

 

 

New Brushes

 

 custom 
palette provides a quick shortcut to 
loading Painter 5’s New Brush libraries. 
Click an icon to load that brush library 
into the Brushes palette.

You will only need to use the 

 

Tools

 

 palette 
and the 

 

Brushes

 

 palette for this lesson. If 
you would like to, hide the other palettes 
by clicking their close box. To display a 
palette, choose 

 

Window menu> Show

 

 
[palette name].

 

Establishing a Clone 

 

Relationship

 

Painter’s cloning feature establishes a 
relationship between the source image and 
the destination image. This relationship 
allows you to trace an image. It also allows 
you to clone. Like an incredible special 
effect, cloning reproduces the source 
image in a new medium. 

 

To get started:

 

Open your own image or choose

 

 File 

menu> Open

 

 and select 

 

GEISHA.JPG

 

 from 
the 

 

TUTORIAL

 

 folder. 

 

To create a clone of GEISHA.JPG:

 

1

 

Choose 

 

File menu> Clone

 

. A new 
image called 

 

Clone of GEISHA.JPG

 

, 
appears.

The cloned image is an exact copy of the 
source image with a digital link to the 
source. Before you can trace the source 
image, you must clear out the 
destination file.

 

The source image is in the background. The 
destination image {foreground) is shown 
with Tracing Paper on.



 

Lesson 1 • Getting Started

 

3

 

2

 

Choose 

 

Select menu> All

 

 to select the 
entire background. Then choose 

 

Edit 

menu> Clear 

 

or press 

 

Delete

 

/

 

Backspace

 

.
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To turn on tracing paper so you can see 
the source image underneath, choose 

 

Canvas menu> Tracing Paper

 

 or 
click the 

 

Tracing Paper

 

 icon.

 

Save your Image

 

NOTE: In the demo version, Save has
been disabled. You will not be able to save.

 

To save your image:

 

1

 

Choose 

 

File menu> Save As

 

.

 

2

 

Name the file 

 

GEISHA TRACING

 

, and 
select a destination folder.

 

3

 

Select the TIFF file format from the pop-
up at the bottom of the dialog and 
click 

 

OK

 

.

 

Click the Tracing Paper icon to toggle tracing 
paper on and off.

 

Before you can trace the Geisha’s face and 
the lines of her umbrella, you must first 
choose a brush.

 

Choosing a Brush

 

The icons on the 

 

Brushes

 

 palette represent 
Painter’s different brushes. Each brush has 
several preset options called variants. You 
choose a variant of the current selected 
brush from the 

 

Variant

 

 pop-up on the 

 

Brushes

 

 palette.

 

Once you are more skilled with 

 

Painter

 

, you can 

 

learn how to create your own variants.

 

The 

 

Scratchboard Tool

 

 is a good choice for 
sketching. It is a variant of the 

 

Pen

 

 brush.

 

To choose the Pen brush:

 

1

 

Choose the 

 

Brush

 

 tool from the 

 

Tools

 

 
palette. 

If the 

 

Brushes

 

 palette is not already 
visible, display it by double-clicking the 

 

Brush

 

 tool on the 

 

Tools

 

 palette or by 
choosing

 

 Window menu> Brushes

 

. 

 

2

 

Choose 

 

Pens

 

 from the 

 

Brushes

 

 palette. 

If the brush is on the face of the drawer, 
click its icon. The icon now has a red 
highlight.  

To choose a brush from inside the 
drawer, first open the drawer by clicking 
on the push bar below the brush icons. 

 

3

 

Close the drawer by clicking on the push 
bar again.

You can also choose a brush without 
opening the drawer by choosing it from 
the pop-up in the lower part of the 

 

Brushes

 

 palette.

 

To use Pens, click the icon.

More tools are located inside the drawer. 
Click the push bar to open the drawer.
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To select the Scratchboard Tool variant:

 

Choose the 

 

Scratchboard Tool 

 

variant from 
the 

 

Variant

 

 pop-up. 

 

You may also select the Pen brush from the 
Brush Library pop-up on the drawer.

Selecting the Scratchboard Tool variant from 
the Variant pop-up.

 

When the 

 

Brush

 

 tool is selected, some 
standard brush options are available on the 

 

Controls

 

 palette. These include 

 

Opacity

 

, 

 

Grain

 

 (how the brush interacts with the 
paper texture), 

 

Size

 

 and 

 

Draw Style

 

.

 

Tracing with Freehand and 
Straight Lines Drawing

With Painter, you can draw freehand, or 
you can choose a straight-line drawing 
style. Freehand allows you to drag, in any 
motion or direction you like. Straight Lines 
will connect each point click with a line and 
can be closed (return to origin) by pressing 
the Return/Enter key.

Begin tracing the Geisha’s face in the 
Freehand Draw Style. 

To make a freehand stroke:

1Click the Freehand radio button on the 
Controls palette under Draw Style.

The Brush tool: Controls palette opens when 
you choose the Brush tool. Use it to choose a 
freehand or straight line drawing style.

Pressing B on your keyboard also sets the draw style to 
Freehand. 

2Position the pointer where you want to 
start painting. 

3Push down on the stylus or hold down 
the mouse button and drag to make a 
mark.

4When you have finished, let up on the 
stylus or release the mouse button.

Any time you make a mark you don’t like, 
use multiple-undo to remove it and start 
over.

Trace the Geisha’s face, hair and kimono.
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To Undo a stroke:

1Choose Edit menu> Undo. 

2To Redo an “undone” operation, choose 
Edit menu> Redo. Redo is generally 
only available immediately after an 
Undo.

Once you have traced her face, hair and 
kimono, use the Straight Line Draw Style to 
trace the lines of her umbrella.

To draw a straight line:

1Click the Straight Lines radio button on 
the Controls palette: Brush tool. 

Pressing U on your keyboard sets the Draw Style to 
Straight Lines. Press the V key to end the current 
polygon and begin a new one.

2Click the stylus or mouse where you’d 
like your stroke to start. You’ll see an 
origin point marker.

3Drag to where you want your stroke to 
finish. Before you release, you can move 
the stylus or mouse around and place 
the finishing point exactly where you 
want it. Release. Painter fills in a straight 
line between the two points.

Navigating your Document

While you are tracing, you may want to 
zoom-in, pan or change your view of the 
document. You can even rotate your page 
to accommodate the way you draw 
naturally.

To adjust your page using the Rotate 
Page tool:

1To rotate the page, first, choose the 
Rotate Page tool from the Tools palette.

The Rotate tool shares a space on the 
palette with the Grabber tool. Click the 
Grabber and choose the Rotate tool from 
the pop-up.

The Straight Lines Draw Style makes tracing 
the umbrella lines easy and quick!

2Drag in the image to rotate it. To return 
the image to its original orientation click 
once in the center of the image. 

3While you are tracing turn Tracing paper 
off to see how your tracing looks.

To zoom in or out of an image using the 
Magnifier tool:

1To zoom in, choose the Magnifier tool 
from the Tools palette.

2Click the part of the image you want to 
enlarge. 

The Rotate Page tool.

Rotate the page if it helps you trace.
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3To zoom out, hold down the Option/Alt. 
This will toggle the cursor to the (-) 
magnifier. Click the area you want to 
reduce. 

To pan an image using the Grabber tool:

1Choose the Grabber tool from the Tools 
palette.

Turn off Tracing Paper to see how your 
tracing looks.

The Option/Alt key sets the magnifier to 
“zoom out.”

2Drag within the image. 

Save your Second Image

Once you finish your tracing, you should 
save the file one last time. Choose File 
menu> Save. Then you can try cloning. To 
make a second version of the original 
photograph, first save it as a TIF file (File 
menu> Save As) with the name, GEISHA 
CLONE. 

Painting in the Clone

Before you can begin painting into your 
tracing, you’ll need to choose a Cloners 
brush.

To select a Cloners brush:

1Choose the Cloners brush icon from the 
Brushes palette.If the icon is not visible 
on the drawer front, open the drawer and 
select the icon.

The Grabber tool.

Any brush can be turned into a cloning brush with the 
Clone Color option. This option is located in the Art 
Materials: Color palette.

2Choose Impressionist Cloner from the 
Variant pop-up. The Impressionist 
Cloner copies data from the clone 
source, and recreates it in chalk. 

3Turn on Tracing Paper, by clicking the 
Tracing Paper icon in the upper-right 
corner of the document window.

4Begin painting the Geisha’s kimono. You 
should see the image coming through, 
rendered in a chalk style. Turn off tracing 
paper to see the result of your efforts.  

The Cloners brush icon.

Select the Impressionist Cloner variant of the 
Cloners brush.
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Save your Third Image

Once you finish painting your clone, you 
should save the file one last time. Then you 
can try AutoCloning. To make a third 
version of the original photograph, first 
save it as a TIF file (File menu> Save As) 
with the name, GEISHA AUTOCLONE.

Using AutoCloning 

With a Cloners brush you can meticulously 
apply each cloning stroke. AutoClone 
makes the strokes for you, almost like 
applying a filter.

Turn Tracing Paper off to see your clone.

To AutoClone:

1Choose Effects menu> Esoterica> 
AutoClone. This gradually paints the 
image by applying dabs of paint. 

Note that because you did not make a 
selection, the effect applies to the entire 
image. 

2Click the mouse button when the image 
has been filled to your liking. Remember 
that you can use the Undo command if 
you don’t like the effect, or if you want to 
start over and change when the painting 
stops.

3In the Brushes palette, choose the Soft 
Cloner variant.

4Set the Opacity to about 10% in the 
Controls palette.

An AutoClone in progress.

5Use the Soft Cloner to bring back some of 
the detail.

Choose the Soft Cloner variant.

Use the Soft Cloner to restore some detail.
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Compositing Three Images

Painter’s powerful cloning feature allows 
you to trace an image, recreate an image in 
a new medium and composite images into 
one. It also lets you use clones to create 
special effects and cool movie techniques. 
Painter 5’s new SuperCloners brushes let 
you clone with multiple points and angles. 
Cloning is almost unlimited in it’s amazing 
capabilities.

You can find out more about SuperCloners brushes in 
Chapter 5 “Cloning and Tracing” of the Painter 5 User 
Guide.

To composite with cloning:

1Choose File menu> Open and open 
each Geisha image. 

2Once the three images are open, you 
must select one to be the destination 
(final) image. We chose GEISHA 
TRACING to be the destination image so 
select it as the active window. 

3Choose the appropriate Cloners brush 
variant. For straight compositing, you 
can use the Straight Cloner. We used the 
Soft Cloner to clone with a softer edge.

4With GEISHA TRACING as the active 
window, choose File menu> Clone 
Source and select GEISHA AUTOCLONE.

5Now paint into GEISHA TRACING. You 
will see the data from GEISHA 
AUTOCLONE coming through. Paint in 
the background, around the eyes and 
along the parasol handle.

6When you are finished cloning a section, 
you are ready to choose a new clone 
source.

7With GEISHA TRACING as the active 
window, choose File menu> Clone 
Source and select GEISHA CLONE.

Choose Clone Source to select the source 
image from the list of open files.

8Now paint into GEISHA TRACING. You 
will see the data from GEISHA CLONE 
coming through. Paint on top of the 
background, in her hair and kimono. 

9Save your final image.

Clone the images in sections for a cool effect.
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Painting with 
Brushes

What is in this Lesson

In this lesson you will learn how to use 
Painter’s brushes--the heart of Painter. 

The lesson is divided into two parts—
Painting with the default Brushes and 
Painting with Painter 5’s New Brushes. 
Painting with Brushes teaches you how to 
select and use Painter’s basic brushes by 
painting on a tracing. Painting with New 
Brushes introduces you to Plug-in Brushes 
as you learn to brush over a photograph, 
changing the pixels underneath. 

Painting with Brushes

Opening an Existing Tracing 
You will begin this lesson by opening the 
tracing of the Geisha image you saved in 
Lesson 1.

To get started:

1Choose File menu> Open.

2Select the GEISHA FINAL file from the 
TUTORIAL folder. This is the file you 
saved at the end of Lesson 1.

3Click Open.

You will need the Tools, Controls, Brushes and Art 
Materials palettes for this lesson. 

4If your screen looks crowded, choose 
Window menu> Zoom To Fit to 
resize the image window to 
accommodate the size of your screen.
Experimenting with Paper 
Texture Effects
Painter provides a wide choice of paper 
textures. Many of Painter’s brushes, such 
as Chalk and Charcoal, interact with paper 
grain. By combining brushes and paper 
textures, you can create amazing effects.

Using Chalk over a Paper Texture

You can fill in the Geisha’s hair using a 
Chalk brush and brushing the chalk over a 
paper texture.

To select the Large Chalk:

1Choose the Chalk brush from the 
Brushes palette.

The traced photograph of the Geisha opens. 
Lesson 2 • Painting with Brushes 9



                                                                  
2Choose Large Chalk from the Variant 
pop-up. 

To select the paper texture:

1If the Art Materials palette is not 
displayed, choose Window menu> 

Show Art Materials.

2Open the Art Materials: Paper 
palette by clicking the Paper icon. 

3Choose the Hatching paper texture. 

One paper texture is always selected and active. Basic 
Paper is the preset paper texture.

Choose the Large Chalk variant of the Chalk 
brush.
10 Fractal Design Painter Tutorial
Now brush in the Geisha’s hair to fill it in 
with the black Large Chalk. Notice that the 
more you work on an area the more the 
paper grain fills in. Experiment with 
painting with light and heavy pressure on 
your tablet and leave some areas with 
white paper showing through for 
highlights. 

Choose the Hatching paper texture.

Brush in her hair with textured brush strokes.
Scaling the Paper Texture

You can increase the grain of the paper 
texture by scaling it.

To scale the paper texture:

1Click the push bar to open the Paper 
Textures palette.

2Drag the Scale slider to increase the 
texture size.

3Brush in the Geisha’s hair to see the 
difference in scale.

Save your Work

It’s a good idea to save your work under a 
new name. This way, you can revert to this 
point if you become dissatisfied with future 
changes.

To save under a new name:

1Choose File menu> Save As.

2In the dialog, type GEISHA - CHALK 
HAIR.

3Select TIF as the file type.

4Locate the disk and folder you want to 
use, and click Save.



                                                  
Inverting the Paper Grain

You can “invert” the grain of the paper 
texture so the “low points” become the 
“high points.” To make this change stand 
out, you can change the color of the brush.

To invert the paper texture:

1In the Paper Textures palette, click 
Invert Paper or choose Paper 
Textures palette: Paper menu> 
Invert Paper.

The Paper Preview shows the new texture. 
Disable and enable Invert Paper a few 
times and see how this setting changes the 
texture when you make a stroke. This will 
be easier to see when you change the 
current color. Leave Invert Paper enabled.

Click Invert paper and make a stroke. It is 
easier to see the result of the inversion if you 
change the current color.
Adding Color

Adding color to an inverted paper texture 
increases the texture effect.

To change brush color:

1Open the Art Materials: Color 
palette by clicking the Color icon.

2Choose an indigo blue color from the 
Color palette. Click or drag in the ring to 
choose a blue hue, and then click or drag 
in the triangle to choose the color.

3Now paint in the highlight area of the 
hair with the blue brush. Notice now that 
the paper grain is inverted as you paint. 

To save time, you can tear the Color 
palette off the Art Materials palette. This 
way it is always accessible, no matter 
what other art material you are using. 

Choose a new brush color.
To tear off a palette:

1Make sure the palette you want is not 
currently active. You can’t tear off the 
current active palette.

2Click the icon for the palette you want, 
such as the color palette, and drag it 
away from the palette.

Continue to add highlights to the hair by 
choosing a contrasting color (such as 
magenta) and brushing over the paper 
texture. 

Paint in the highlights with the blue color, 
over the inverted paper texture.
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Changing Paper Texture

Different paper textures can change the 
look of a brush stroke dramatically. You 
can select a different paper texture and 
paint in the kimono.

To paint in the kimono:

1Choose the Eggscape paper texture from 
the Art Materials: Paper palette. 

2On the Paper palette, move the Scale 
slider to the right to scale the paper 
texture up to 250%.

3Choose a color from the Color palette.

4Choose the Chalk brush from the 
Brushes palette.

5Choose Large Chalk from the Variant 
pop-up.

6Fill in the kimono.

Make sure that you paint lightly enough to 
leave some white showing and the large 
scale paper texture will show up looking 
like a fabric pattern.

Later you’ll be going back over this area 
with a watercolor wash. So keep that in 
mind when you pick your color, knowing 
that the area you now leave white will be 
filled with your watercolor choice later.
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Be sure to save your changes. 

Choosing and Using Different 
Brushes
In this part of the lesson, you will learn how 
to choose and use four different brushes 
that come with Painter:

• Airbrush: Fat Stroke variant

• Watercolor: Simple Water variant

• Felt Pens: Felt Marker variant

• Brush: Big Wet Ink variant

You will also learn how to adjust brush Size 
and Opacity. These settings are available in 
the Controls palette: Brush tool.

Fill in the kimono using the Eggscape paper 
texture.
Painting with the Airbrush 

The Airbrush gives a nice bold contrasting 
effect to the pen-and-ink nature of the 
Geisha image.

To apply the airbrush:

1Change the paper texture back to Basic 
Paper by choosing it in the Art 
Materials: Paper palette. 

2Choose the Airbrush from the Brushes 
palette.

3Choose Fat Stroke from the Variant 
pop-up.

4Pick any color you want in the Color 
palette.

5Start coloring in the background, 
applying the airbrush to the parasol 
pleats.

6Color in the lips too.

Your brush strokes don’t have to be exact. 
Just play with the brush and have fun. 



Adjusting the Brush

Notice that the Controls palette gives you 
several options for adjusting your brush. 
The Controls palette changes when you 
choose a new tool. 

The Controls palette lets you increase or decrease 
brush Size, Opacity, or Grain. Brush Size describes 
the size of the brush dab. Opacity refers to the degree 
the stroke covers or builds up on the underlying colors, 
from transparent to opaque. Grain controls how much 
color penetrates into the paper texture. You can also 
set the brush to paint straight lines or freehand style. 

Paint in the parasol pleats with the airbrush.

You can change brush Size, Opacity and 
Grain on the Controls palette: Brush tool.
To adjust the brush:

1In the Controls palette, drag the Size 
slider so the Airbrush is set to a size of 
about 30.

2Drag the Opacity slider to about 75%.

3For easy straight lines, click the Straight 
Lines button to apply your airbrush 
stroke between every point you place as 
you click in your artwork. 

Experiment with these settings until you 
have a brush stroke you like. 

Using Advanced Brush Options

Advanced brush options let you control the 
way material is layed out on the canvas. 
These options are found in the Brush 
Control palettes. You can open the Brush 
Control palettes by choosing one (the Size 
palette for example) from the Brushes 
palette: Control menu>.

If you don’t want to open a Brush Control 
palette, you can customize the Controls 
palette: Brush tool to expand to reveal 
these controls. You will set these 
“advanced” options specific to the selected 
brush variant. If the option is not available 
for the current selected brush variant, it 
will be unavailable (grayed-out).
To customize and expand the Controls 
palette for the Simple Water variant:

1Choose the Water Color brush from the 
Brushes palette.

2Choose Simple Water from the Variant 
pop-up.

3Choose Brushes palette: Control 
menu> Custom Controls.

4In the Custom Controls dialog, select 
Water from the Category pop-up.

5Enable the Diffusion and Wet Fringe 
checkboxes and click OK.

6Click the zoom box in the upper right 
corner of the Controls palette to hide/
show the new custom controls.

Choose Custom Controls from the Brushes 
palette: Control menu.
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7Choose Brushes palette: Brush 
menu> Save Variant. This saves the 
changes to the Controls palette so the 
new controls are available every time 
you choose the Simple Water variant of 
the Water Color brush. 

Note: Saving the variant saves all aspects of 
the current brush variant. Make sure you 
are not replacing the default state with 
unwanted changes.

Using Water Color Options

Before using the new options on the 
Controls palette, choose a color. From the 
Color palette, choose a color that will go 
nicely with the color you sketched for the 
kimono fabric. 

You will use the option s to apply a 
watercolor over the existing chalk paper 
texture.

Click the zoom box to expand and contract 
the customized Controls palette.
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To use the Controls palette options for 
the Simple Water variant:

1With the Brush tool and Water Color 
brush and the Simple Water variant 
selected, expand the Controls 
palette: Brush tool.

The options that appear in the Controls 
palette include Diffusion and Wet Fringe.

2Paint a few strokes into the kimono area. 
In the Water palette, move the Diffusion 
slider to the right to increase diffusion. 

The Diffusion slider varies the spread of wet paint on 
the paper. The Wet Fringe slider adjusts how much 
paint wells up at the edge and ends of your stroke.

3Paint more strokes and play with these 
controls to see how they affect your 
brush strokes. 

Finishing Up

We finished the image with the Felt Marker 
variant of the Felt Pens brush and the Big 
Wet Ink variant of the Brush. Use the Felt 
Marker to fill in the parasol handle. Use the 
Big Wet Ink to add foliage to the upper 
right of the image.

To use Big Wet Ink:

1Choose the Brush from the Brushes 
palette. 

2Choose Big Wet Ink from the Variant 
pop-up.

3Choose a dark green color from the 
Color palette.

4Paint in the basic shape of the foliage. 

Create a customized Controls palette to use 
advanced Water Color brush controls.



5Choose lighter shades of leaf colors to 
work back over the dark green area. 

Saving Image for Later
Once you’ve finished painting over the 
tracing of the Geisha, save the final version 
as a TIF file (File menu> Save As) with 
the name GEISA PAINTED. 

Painting with New Brushes

This part of Lesson 2 will introduce you to 
the Plug-in Brushes, new to Painter 5. 
Dozens of new brushes in 6 different 
categories are at your disposal through 
Painter’s extensible plug-in architecture.

For this part of the lesson, you’ll use plug-in 
brushes to paint over and manipulate an 
existing photograph. Not only does this let 

Finishing up with the Big Wet Ink variant.
you create unusual, stunning effects, it also 
allows you to do photo retouching, such as 
adding saturation to a photo. 

Open an Existing Image
Begin by opening the image, a photograph 
of an Osaka castle.

To get started:

1Choose File menu>Open.

2Select the OSAKA CASTLE.JPG file from 
the TUTORIAL folder.

3Click Open. 

The Osaka Castle image.
Selecting and Using Plug-in 
Brushes
You access Plug-in brushes through the 
Shortcut to New Brushes Custom palette, 
which opens when you start Painter. The 
Shortcut to New Brushes Custom palette 
contains an icon for each new brush 
library. When you click the icon, that 
library becomes the current brush library.

The six categories of Plug-in Brushes are:

• F/X

• Gooey

• Layer

• Mouse

• New Paint Tools

• Photo

• Super Cloners

Within each category, you will find several 
brush variants. For example, the F/X Plug-in 
Brush provides five variants.

The brushes you will use in this lesson 
include the following (categories appear in 
parentheses):

• Add Grain (Photo)

• Hue Sat (Photo)

• Bulge (Gooey)

• Saturation Add (Photo)

• Glow (F/X)
Lesson 2 • Painting with Brushes 15



• Fire (F/X)

• Blur (Photo)

• Relief (Photo)

• Left and Right Twirl (Gooey)

As you use each brush, be sure to 
experiment with different amounts of 
pressure, direction of brushing, colors and 
so on. Feel free to play and have fun on 
your own.

Using the Add Grain Variant of the 
Photo Brush

The first plug-in brush you will use is the 
Add Grain variant of the Photo brush. This 
brush lets you brush paper grain onto an 
image. Before you use the brush, you must 
select a paper texture.

To use the Add Grain variant:

1Open the Art Materials: Paper 
palette.

2Choose the Eggscape paper texture.

3Click the Photo icon on the Shortcut to 
New Brushes Custom palette. 

4Choose the Photo brush from the 
Brushes palette.
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5Choose Add Grain from the Variant 
pop-up.

6Working in the Osaka Castle photo, paint 
into the overhanging foliage to grainize 
the area.  

Using the Hue Sat Variant of the Photo 
Brush 

Next, you will retouch the photo by 
changing the color of the sky.

To use the Hue Sat variant:

1Choose the Photo brush from the 
Brushes palette.

2Choose Hue Sat from the Variant pop-up.

Adding grain to the foliage at the top of the 
photo creates an interesting look.
3Choose Art Materials: Color palette, 
and choose a soft pastel color.

A pastel blue or pink makes a nice choice 
for the sky.

4With your stylus, paint in the sky area of 
the Osaka Castle photo.

5Then, choose a different pastel color 
from the Color palette, and apply that 
color to the sky.

6Change colors again to fill in the sky with 
several pastel colors. 

Using the Hue Sat brush to add pastel colors 
to the sky.



Using the Bulge Variant of the Gooey 
Brush

Now let’s have some fun. This time, you will 
use the Gooey brush’s Bulge variant to 
transform the castle windows.

To use the Bulge variant:

1Click the Gooey icon on the Shortcut to 
New Brushes Custom Palette. 

2Choose the Gooey brush from the 
Brushes palette.

3Choose Bulge from the Variant pop-up.

4Brush in tight circular motions within all 
the windows to bulge them.

The initial point of your stylus becomes the 
focal point for the bulge effect. 
Using the Saturation Add Variant of 
the Photo brush

With the Saturation Add plug-in brush, you 
can remove or distort color in an image. 
Here, you will use the Saturation Add 
brush to change the color of the castle and 
the sky surrounding it.

To use the Saturation Add variant:

1Click the Photo icon on the Shortcut to 
New Brushes Custom palette. 

2Choose the Photo brush from the 
Brushes palette.

3Choose Saturation Add from the Variant 
pop-up.

Using the Bulge brush.
4Choose Art Materials: Color palette, 
and select a very light color, white for 
example. 

Adjusting the color selection from dark to light 
changes how Saturation Add works. Dark removes 
color (bleaches it out) and light distorts color (making 
it highly saturated).

5Paint in the castle.

Distort the color of the bug eye windows 
and the sky around the edge of the castle 
to make it brighter and wild. 

Choose white in the Color palette to create 
high saturation with the Saturation Add brush 
variant.
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6Adjust the color in the Color palette to a 
very dark color, like black. 

7Paint in the body of the castle to remove 
its color, transforming it into a black and 
white image. 

Using the Glow Variant of the F/X 
Brush

With the Glow brush, one of the F/X plug-in 
brushes, you can brush in neon color.

To use the Glow variant:

1Click the F/X icon on the Shortcut to New 
Brushes Custom palette. 

2Choose the F/X brush from the Brushes 
palette.

3Choose Glow from the Variant pop-up.

4Open the Art Materials: Color 
palette, and select a bright color.
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5Paint lines at the roof edges to simulate 
glowing neon lighting. 

Using the Fire Variant of the F/X Brush

Every party needs flaming tiki torches out 
in front of the house! To transform the 
Osaka castle even more, you’ll use the Fire 
brush to add flames, like those from tiki 
torches.

To use the Fire variant:

1Choose the F/X brush from the Brushes 
palette.

2Choose Fire from the Variant pop-up.

3Choose whatever color you’d like from 
the Color palette.

Add a neon effect with the Glow variant of 
the F/X brush.
The color you choose will determine the 
color of your glowing flames. We chose a 
red-orange color.

4Brush the flames into the bottom of the 
photo. 

Using the Relief Variant of the Photo 
Brush

Next you’ll use the Relief brush to create 
texture over the body of the castle and the 
stone wall in front of it.

To use the Relief variant:

1Click the Photo icon on the Shortcut to 
New Brushes Custom palette. 

Use the Fire variant of the F/X brush to 
create flames. 



2Choose the Photo brush from the 
Brushes palette.

3Choose Relief from the Variant pop-up.

4Brush in the castle body and the stone 
wall.

The more pressure you apply as you brush, 
the more of the building and stone textures 
emerge. 

Add relief to the face of the castle and its 
stone wall. with the Relief variant of the 
Photo brush.
Using the Left and Right Twirl Variants 
of the Gooey Brush

To further distort the Osaka Castle photo, 
you’ll use the Left Twirl and Right Twirl 
brushes to create twirls in the foliage 
above the building.

To use the Left and Right Twirl variants:

1Click the Gooey icon on the Shortcut to 
New Brushes Custom Palette. 

2Choose the Gooey brush from the 
Brushes palette.

3Choose Left Twirl from the Variant 
pop-up.

4In the foliage above the castle, brush in a 
circular motion in a counter-clockwise 
direction. 

You can also paint in clockwise 
direction, but for a Left Twirl, counter-
clockwise makes more sense.

5Now choose the Gooey brush from the 
Brushes palette.

6Choose Right Twirl from the Variant 
pop-up.
7In the foliage above the castle, brush in a 
circular motion in a clockwise direction. 

Using the Blur Variant of the Photo 
Brush

Last but not least, now you’ll use the Blur 
variant to add a blurring effect to the top of 
the tiki torch flames, simulating heat 
vapors.

To use the Blur brush:

1Click the Photo icon on the Shortcut to 
New Brushes Custom Palette. 

2Choose the Photo brush from the 
Brushes palette.

3Choose Blur from the Variant pop-up.

Using Left and Right Twirl variants of the 
Gooey brush to create swirls in the leaves.
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4Brush in an upward direction in the top 
of the flames to blur them.

5To distort the flames a bit more, try 
using the Gooey brush’s Diffuse Pull 
variant. 

Click the Gooey icon on the Shortcut to 
New Brushes Custom Palette. Choose the 
Gooey brush from the Brushes palette 
and choose Diffuse Pull from the Variant 
pop-up.

Save the Image for Later
Once you’ve finished painting over Osaka 
castle photo, save the final version as a TIF 
file (File menu> Save As) with the name 
OSAKA CASTLE FINAL. 

Using the Blur and Diffuse Pull brushes to 
create a heat vapor effect.
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3
The Image Hose

What is in this Lesson

In this lesson, you will learn how to paint 
with the image hose, a revolutionary 
painting tool that lets you paint with 
images instead of color. The Image Hose 
lays down a variety of changing images, 
allowing you to create realistic looking 
imagery made from pieces of photographs 
or original art.
When you use the Image Hose brush, you 
select a nozzle. The nozzle determines 
what images you paint with.

In Painting with the Image Hose you’ll 
learn how to use some of the Image Hose 
nozzles that come with Painter to create an 
image. In Creating a Nozzle, you’ll learn 
how to make an Image Hose nozzle from a 
group of floaters. Floaters are images that 
hover over the canvas. For more 
information, refer to Chapter 11, “Floaters” 
in the Painter 5 User Guide.

Painting with the Image 
Hose

In this part of Lesson 3, you’ll create an 
image by painting with the Image Hose. 
You’ll use a variety of the default nozzles, 
including:

• Cumulus Clouds

• Small Forest

• Mediterranean Village

• Stones

When you are finished with this lesson, 
you’ll have an image of a Mediterranean 
Village on a hillside.
Prepare Your File
To begin this lesson, make a new file and 
create a blue sky by filling with a gradation.

To create a new file:

1Choose File menu> New. 

2Create a new picture that is 400 pixels 
(width) by 500 pixels (height) with 
resolution set to 72 ppi.

3Click OK.

To fill your new file with a gradation:

1Open the Art Materials: Color 
palette. Choose a light blue as your 
primary color (foreground rectangle).

Leave white selected as the secondary 
color (background rectangle).

2In the Art Materials: Grad palette, 
choose Two-Point from the pop-up.

Create a new picture 400x500 pixels.
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3Drag the red ball in the Rotation Ring 
to 90˚.

4Choose Effects menu> Fill.

5In the FIll dialog, choose Gradation and 
click OK.

Create a gradation for your sky.

Fill your new image with a gradation to 
create a blue sky.
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Painting with the Cumulus 
Clouds Nozzle
First, you’ll paint some clouds into the blue 
sky using the Cumulus Clouds nozzle. 

To select an Image Hose nozzle:

1Choose the Image Hose from the 
Brushes palette.

2Choose Medium Random Spray from the 
Variant pop-up.

The Image Hose variants control the spacing and 
sequence of the individual nozzle elements. Large, 
Medium and Small refer to the spacing between the 
elements as they are laid down. Random and 
Sequential refer to how the different nozzle elements 
are chosen. The Sequential variants choose each 
element in the order they appear in the nozzle file. 
Linear or Spray indicate whether the elements are laid 
down in a line or randomly. For more information 
about the Image Hose, refer to Chapter 7, “The 
Image Hose” in the Painter 5 User Guide.

You must select a nozzle before you can 
begin painting. You do this in the Nozzle 
palette.

3To open the Nozzle palette, choose 
Brushes palette: Nozzle menu> 
Nozzles. 
The Nozzle palette displays a few 
thumbnails from the default nozzle file, 
the name of the current nozzle in the 
Nozzle library pop-up, and the Scale 
slider.

4Choose Cumulus Clouds from the Nozzle 
Library pop-up.

Now paint in the sky and watch the clouds 
appear. 

The Nozzle palette is where you select a 
nozzle for the Image Hose.

Painting in clouds.



                                                                       
Adjusting the Nozzle
Painter gives you basic controls for 
adjusting how the nozzle lays down images. 
The basic controls are:

• Scale (size of the images) located on the 
Nozzle palette.

• Opacity (transparency of the images) 
located on the Controls palette: Brush 
tool.

• Grain (Secondary color mixed into 
images) located on the Controls 
palette: Brush tool.

In this lesson, only the basic controls will 
be explored.

More advanced controls are available when you 
expand the Nozzle palette. Rank describes how the 
nozzle files are arranged, small to big for example. The 
Rank sliders determine how a nozzle’s images come 
out when you paint—sequentially, randomly, or based 
on source or pressure. In the example of Rank 1 
“small to big,” set to Pressure, when you press 
harder a larger image comes out. For more information 
about setting the Rank sliders in the Nozzle palette, 
refer to Chapter 7, “The Image Hose” in the Painter 5 
User Guide.
Changing the Scale

You can control the size of the images that 
come out of the Image Hose by using the 
Scale slider in the Nozzle palette. 

To adjust the scale of the clouds:

1In the Nozzle palette, drag the Scale 
slider to the left for smaller clouds or to 
the right for larger ones.

2Brush in the image to see your scale 
changes take effect.

Adjusting the Opacity and Grain

Now adjust the opacity of the clouds to 
make them look more like fog.

When the Nozzle palette expands, advanced 
controls are displayed.
To adjust the opacity:

1In the Controls palette: Brush tool, 
drag the Opacity slider to the left to 
reduce opacity to about 10%. 

2Brush in the bottom of the image to 
add fog. 

Next, use the Grain slider to control the 
color of the cloud images based on the 
current background color. That is, the less 
the grain, the more the background color 
appears.

Drag the Opacity slider to the left to lower 
opacity for the fog.

Brush fog in the image.
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To adjust the grain:

1First, set your colors. To bring in more of 
the blue color, click the swap arrow icon 
by the color rectangles in the Controls 
palette: Brush tool. 

If you need to reset the background color to blue, open 
the Color palette, click the background color chip to 
select it and then choose your color. 

2In the Controls palette: Brush tool, 
drag the Grain slider to the right (100%), 
and brush in some clouds.

3Now drag the Grain slider to the left to 
about 25%, and brush again to see the 
difference.

Painting with other Default 
Nozzles
Now you’ll use four other nozzles to add to 
your image. First, you’ll use the Small 
Forest nozzle to paint small trees on a 
curve, to simulate a hillside horizon line. 

Drag the Grain slider to the left to bring in 
more of the Secondary color.
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Then you’ll use the Mediterranean Village 
nozzle to intersperse some buildings in the 
forest.

Adding Trees and Buildings

To paint in the small trees:

1Choose Small Forest from the Nozzle 
library pop-up.

2Starting about two-thirds down on the 
left side of the image, brush with an 
upward curving motion to the right side 
of the image.

Your tree line should look like it’s on a 
hillside.

To add the buildings:

1Choose Mediterranean Village from the 
Nozzle library pop-up.

2In the Nozzle palette, set the Scale slider 
to a small percentage.
3Lightly brush in a few images to 
intersperse some buildings amongst the 
trees.

4Use the Scale slider to make the nozzle’s 
images smaller.

5Use the Grain slider in the Controls 
palette: Brush tool with white as the 
background color to give the images a 
distance fade look. 

Painting buildings along the tree line.



6Work toward the foreground, increasing 
the scale and grain as you do.

Stones

Next, use the Stones nozzle to create a 
stone archway in the foreground of your 
scene.

To add the stone archway:

1Choose Stones from the Nozzle library 
pop-up.

2Begin at the lower left of your image and 
brush up and over, creating an arching 
pattern of stones.

Trees and buildings added to the image.
3Play with the Grain slider and the 
background color setting to vary the 
color of the stones. Adjust the Scale 
slider to vary the size. 

Ivy

The last nozzle you’ll use on your image 
will be Ivy, which adds the illusion of ivy 
creeping on the stone archway.

To add the ivy:

1Choose Ivy from the Nozzle library 
pop-up.

2Brush in the ivy along the stones. 

Adding the stone archway.
3Again, you can adjust the scale and grain 
of the images as you work. 

Saving the Image
Now that you’re finished, be sure to save 
your work. Save the file as a TIF (File 
menu> Save As) with the name, HILLSIDE 
VILLAGE.TIF. You will use this image later 
in this lesson.

Painting creeping ivy over the stones.
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Creating Your Own Nozzle

In this part of Lesson 3, you will learn how 
to create your own Image Hose nozzle. The 
easiest way to make a nozzle is from a 
group of floaters. The steps you’ll take are:

• Select the floaters

• Make the Nozzle from the floaters

• Paint with the nozzle

• Add your nozzle to the library

When you’re done with this part of the 
lesson, you will have created a nozzle of 
seagulls to paint in the sky of the 
Mediterranean hillside image.

Selecting the Floaters
The first step to creating your own nozzle 
is to select (or create) the floaters to use as 
the nozzle’s images. In this lesson, you’ll 
use floaters stored in the Gulls! library, in 
the TUTORIAL folder in the PAINTER 5 
folder.

To open the Gulls! library:

1Make sure the Objects palette is open. If 
it isn’t, choose Window menu> Show 

Objects.

2Click the Floater icon in the Objects 
palette to display the Floater List palette. 
This will help you work with the floaters.
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3Choose Objects palette: Floater 
menu> Floater Portfolio.

The current floater portfolio opens. Each 
icon represents each floater in the 
portfolio. 

4Choose Floater Portfolio: Floater 
Library pop-up> Load Library. 

5In the dialog, locate the Gulls! Floater 
library in the Tutorial folder in the 
Painter 5 folder. 

Notice that the right side of the dialog 
shows a thumbnail of every image in the 
selected library.

6Click Open. 

The default Floaters portfolio.

In the Load Library dialog, locate Gulls! and 
click Open.
Make the Nozzle from the 
Selected Floaters
Now you’ll create your nozzle from the 
seagull floaters. This process involves 
grouping the floaters and then making the 
nozzle from the group.

To make the nozzle from the floaters:

1Choose File menu> New to create a 
new canvas that is 750 x 250 pixels at 
72 ppi.

2Choose the Adjuster tool from the Tools 
palette.

3One at a time, click on an icon and drag 
each of the five gulls in the floater 
portfolio onto your canvas. Begin by 
dragging the first gull image all the way 
to the left side of the canvas, and arrange 
each gull to the right of the last one.

The Adjuster tool selects floaters.

The Gulls! floater portfolio opens to reveal 
the seagull images. Click on an icon and drag 
it to your canvas.



4With the FLoater Adjuster, drag a 
marquee around all the gulls to select 
them. 

5To group the selected floaters, click the 
Group button in the Objects: Floater 
List palette.

6Now make your nozzle by choosing 
Brushes palette: Nozzle menu> 
Make Nozzle From Group.

The canvas shows your new nozzle, with 
the seagull images appearing on a black 
background. Notice that the images are 
in the reverse order of how you dragged 
them onto the canvas.

Nozzle files must be saved in RIFF format 
before you can load them and paint with 
them.

Selecting all the seagulls.

Chose Make Nozzle from Group to create 
your new nozzle. 
7Choose File menu> Save, name your 
file GULLNOZ.RIF and click Save.

8Choose File menu> Close to close 
your file.

Painting with Your Nozzle
Now that your nozzle is created and saved 
as RIFF file, you can use it to paint with, just 
as you’d use any of the Image Hose nozzles 
that comes with Painter. In this exercise, 
you will paint seagulls into the 
Mediterranean Village scene.

To paint with your nozzle:

1Open your Mediterranean Village scene 
from the beginning of this lesson—
HILLSIDE VILLAGE.TIF.

2Choose the Brush tool from the Tools 
palette.

3Choose the Image Hose brush from the 
Brushes palette.

4Choose Brushes palette: Nozzle 
menu> Load Nozzle. 

5In the dialog, select your GULLNOZ.RIF 
file and click Open.

Paint some gulls into the sky above the 
stone archway in your Mediterranean 
scene.
As you paint, experiment with the Scale, 
Opacity and Grain sliders to vary the 
effects.

To see the contents of your nozzle file, choose 
Brushes palette: Nozzle menu> 
Check Out Nozzle. 

Your Mediterranean scene, created entirely 
with the Image Hose, is now complete.
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Adding Your Nozzle to the 
Library
You can save your nozzle to current 
library, which makes it available each time 
you load the library.

You can change the current Nozzle library at any time 
by choosing Nozzle palette: Library 
pop-up menu> Load Library. Remember 
that a library stores many nozzles, while a nozzle file 
stores several small images.

To add your nozzle to the library:

1Choose Brushes palette: Nozzle 
menu> Add Nozzle to Library.

2In the dialog, type the name you want to 
use for your nozzle and click OK.

The nozzle appears in the Nozzle palette 
as the current nozzle. It will be there the 
next time you launch Painter.
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Be careful not to overload your default libraries. It 
takes additional memory to load larger libraries. You 
can always create new libraries and transfer library 
items between libraries or delete items using the 
Movers. For more information about Libraries and 
Movers, refer to Chapter 1, “Painter’s Interface” in the 
Painter 5 User Guide.



                                       
4
Retouching and 
Applying Effects 
to a Photo
What is in this Lesson 

While Painter is famous for Natural-Media 
painting, you can also use Painter to 
retouch and color-correct photographic 
images or to apply special effects to them. 
In this lesson, you will learn how to do 
both.

The lesson is divided into two parts. 
Repairing a Damaged Photo teaches you 
how to use Painter’s retouching and color-
correction tools. Applying Effects to a 
Photo introduces you to some of the cool 
new effects you can achieve with Painter 5.

Repairing a Damaged 
Photo

In this part of Lesson 4, you will learn 
how to:

• Remove scratches and fix torn photos

• Adjust the black and white points

• Color-correct a photo
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Removing Scratches and 
Repairing Tears
Begin by opening a damaged image. The 
LIGHTHOUSE.JPG photo is a good 
example because it has been scratched and 
torn at the corner. It also lacks clear 
contrast and has a color cast.

To begin with your damaged image:

1Choose File menu>Open.

2Select the LIGHTHOUSE.JPG file from 
the TUTORIAL folder.

3Click Open. 

The LIGHTHOUSE.JPG image is torn and 
scratched.
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Using the Scratch Remover Variant of 
the Photo Brush

Painter 5 has a new and powerful tool, the 
Scratch Remover, which is specifically 
designed to remove scratches from 
photographs. The Scratch Remover variant 
of the Photo brush works by sampling the 
area around the scratch to fill it in as you 
brush in the image.

To use the Scratch Remover:

1If the Shortcut to New Brushes Custom 
palette is not visible, choose Window 

menu> Custom Palette> Shortcut to 

New Brushes. 

2Click the Photo icon on the Shortcut to 
New Brushes Custom palette to load the 
Photo brushes into the Brush library.
30 Fractal Design Painter Tutorial
3Choose Scratch Remover from the 
Variant pop-up.

4Brush directly on the lint and scratch 
marks around the top of the lighthouse 
to remove them.

You may want to zoom in on the areas that need 
retouching. If the Tools palette is not visible, choose 
Window menu> Show Tools. Choose the 
Magnifier tool from the Tools palette. Drag in the 
image to magnify that portion.

Choose the Scratch Remover variant of the 
Photo brush.
Tip: Reduce the size of the Scratch 
Remover to retouch detailed areas, such as 
the edge of the lighthouse. 

Using the Soft Cloner Brush

Next, you will repair the torn corner of the 
LIGHTHOUSE.JPG image using the Soft 
Cloner variant of the Cloners brush. This 
brush works by copying data from the 
clone source and recreating it in a process 
called point-to-point cloning. Here, you 
paint using the image area to the left of the 
tear to replace the missing sky to the right.

To use the Soft Cloner brush:

1Choose the Cloners brush from the 
Brushes palette.

2Choose Soft Cloner from the Variant 
pop-up.

3Hold down the Control /Shift key, and 
click in the sky area of the image just to 
the left of the tear.

When you click, the cursor changes to a 
crosshair, indicating that you’ve set the 
initial point of your source area. 

You can use the Controls palette to adjust 
brush size.



                                    
4Release the Control/Shift key, and move 
your stylus over the torn area.

Now start painting over the tear. 

The source area that you selected in step 
two is now being used as your painting 
material. You may want to reselect the 
source area from time to time as you 
continue to fill in the tear. That way, the 
torn area will have a more realistic 
appearance. 

Set the initial point of your source area.

The scratches and tears are repaired.
Adjusting Black and White 
Points
The LIGHTHOUSE.JPG image lacks clear 
contrast. You can adjust black and white 
points to increase contrast in an image 
using Painter’s Equalize effect.

To adjust the black and white points:

1Choose Effects menu> Tonal 
Control> Equalize.

The Equalize dialog appears. The 
Equalize dialog holds the controls to 
adjust white and black points (under the 
image histogram) and overall brightness 
with the Brightness slider.

When the Equalize dialog opens, Painter automatically 
adjusts the lightest parts of the image to white and the 
darkest to black. In most cases, this produces pretty 
good results.

Use the Equalize dialog to improve image 
contrast and tonality.
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Adobe Photoshop users will note the similarity of 
these controls to Photoshop's Adjust Levels dialog. 
In Painter, the Brightness slider adjusts the midtones 
or “gamma” of the image, like the middle slider of 
Photoshop's Levels control.

The histogram displays the range of 
tonal values in this image. The horizontal 
axis maps the image tones from black 
(100%) on the left to white (0%) on the 
right. The height of the histogram 
indicates how many image pixels have 
that particular lightness/darkness value. 
The black and white triangles let you set 
the darkest and lightest colors in the 
image.

As you slide the black triangle, notice 
that the image gets darker. All of the 
pixels in the histogram to the left of the 
black triangle are converted to pure 
black. As you slide the white triangle, the 
image pixels in the histogram to the right 
of the it are converted to pure white. 
This lightens the entire image.

2Return the black and white triangles to 
their initial values: 84.9% black and 7% 
white.
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3Click OK to equalize the image. 

Color-correcting the Photo
You can correct color casts and make other 
tonal adjustments using the Correct Colors 
feature. With this feature, you can manually 
adjust a tonal curve.

To color-correct the photograph:

1Choose Effects menu> Tonal 
Control> Correct Colors. The Correct 
Colors dialog appears, containing four 

The LIGHTHOUSE.JPG image is equalized.
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different sets of tonal controls: Contrast 
and Brightness, Curve, Freehand and 
Advanced. 

2Choose Curve from the pop-up.

The Curve control in the Correct Colors dialog provides 
you with a tonal curve that you can interactively shape 
to accomplish almost any kind of tonal adjustment you 
want. For complete information on the Correct Colors 
Curve, refer to Chapter 13, “Image Effects” in the 
Painter 5 User Guide.

The Correct Colors dialog. 
3Since you will only be adjusting the red 
values in the image, click the red square 
in the dialog. 

4To increase the amount of red in the 
image, start with the midtones: position 
your cursor at the center of the curve 
and drag up and to the left to displace 
the curve. 

When you release the cursor, the image 
reflects your changes.

5Adjust the curve until you have 
approximately corrected for the cyan 
cast.

Click to select the color you want to adjust.

Adjust the red curve to correct the cyan cast.



                 
If you don’t like your changes and want 
to start over, click Reset in the Correct 
Colors dialog. 

6Click OK to apply your changes.

Saving Image for Later
Now save this image; you will use it later in 
this lesson to apply some special effects. 
Save the file as a TIF (File menu> Save 
As) with the name LIGHTHOUSE 
RETOUCHED.TIF and select a destination 
folder. 

The image has more accurate color after 
color correction.
Applying Effects to a Photo

In this part of Lesson 4, you will learn how 
to apply cool effects to a photo, including:

• Pop Art Fill

• Surface Texture

• Lighting

• Custom Tile Effect

Applying a Pop Art Fill
Painter 5 gives you a new image effect 
called the Pop Art Fill. With bold colors 
and half-tone dots, your photos can look 
like a pop work of art in no time.

Applying the Pop Art Fill can be as simple 
as choosing Effects menu> Esoterica> 
Pop Art Fill, and then clicking OK in the 
dialog. However, to get the best results, 
you’ll want to follow these tips:

• Posterize the image to limit its number of 
color levels.

• Turn your image into a negative before 
using the Pop Art Fill. Pop Art Fill creates 
a negative of your image—do this first to 
end up with a positive image.

• In the Pop Art Fill dialog, experiment with 
various settings to fine-tune your effect.
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Posterizing the Image

Starting with a photograph with a limited 
number of color levels yields the best 
results for the Pop Art Fill. This can be 
done by Posterizing the image. 

To posterize the image:

1If the lighthouse image is not already 
open from the previous steps, choose 
File menu> Open and open the 
LIGHTHOUSE RETOUCHED.TIF image.

2Choose Effects menu> Tonal 
Control> Posterize. The Posterize 
dialog appears. 

3Type 4 in the Levels entry box to set the 
number of color levels to 4.

Notice that the dialog’s Preview window 
updates to show your changes. 

The Posterize dialog lets you specify the 
color levels.
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4To see to another part of the image in the 
Preview window, drag in the Preview 
window until the part you want is visible.

5Click OK to finish posterizing the image.

Move the image in the Preview window.

The image is posterized with four color 
levels.
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Turning the Image into a Negative

Because the Pop Art Fill turns the image 
negative, you will want to start out with a 
negative if you want the result to be 
positive.

To turn the image into a negative:

1Choose Effects menu> Tonal 
Control> Negative. 

The negative of the image.
Applying the Fill

Now you are ready to apply the Pop Art Fill.

To apply the Pop Art Fill:

1Choose Effects menu> Esoterica> 
Pop Art Fill. The Pop Art Fill dialog 
appears. 

2Choose Image Luminance from the Using 
pop-up. 

3Set Scale to 50%, Contrast to its highest 
setting (400%) and Dab Color to 
something neutral, like a dark Earth-tone 
green. 

The Invert option only applies to the 
dots; you don’t need to use it for this 
lesson.

The Pop Art Fill dialog.



4Click OK to apply the effect. 

Saving the Image

If you want to save your Pop Art Fill, you 
can do so now. Be sure to save it to a 
different name, because you will be using 
the LIGHTHOUSE RETOUCHED.TIF image 
in the next exercises. If you like the results 
of the next few exercises, save the files as 
new names. However, saving these files is 
not necessary for the Painter 5 tutorial. 

Save the file as a TIF (File menu> Save 
As) with the name LIGHTHOUSE POP 
ART.TIF and select a destination folder.

Your finished Pop Art Fill should look similar 
to this.
Applying Lighting
Now you will learn how to apply lighting to 
an image. Here, you’ll add a cool effect by 
placing a bright beam of light onto the 
image, as if the lighthouse beacon were 
shining.

To apply lighting to the image:

1Open the color corrected photo named 
LIGHTHOUSE RETOUCHED.TIF, which 
you saved earlier in this lesson before 
you applied the Pop Art Fill.

2Choose Effects menu> Surface 
Control> Apply Lighting. The Apply 
Lighting dialog appears.

3Click Plain Light from the presets to 
simulate a lighthouse beacon.

There are many types of light options 
available. To see more options, scroll 
below the light icon area.

4Set the sliders for the light as shown 
below.
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5In the Preview window, specify the light 
source and direction as follows: drag the 
larger circle (representing the light 
source) so it is on top of the lighthouse’s 
beacon window. Drag the smaller circle 
(representing light direction) around to 
the left to -180 degrees. Drag the larger 
circle to the right to adjust the position 
of the light indicators so they look like 
the ones shown above.

Working with the light indicators in the 
Preview window can be tricky. For 
example, if you click the smaller circle 
again, you create another light direction. 
If you create a new light, press the 
Delete/Backspace key to remove it.

6If you want to save your lighting 
specifications, you can do so by clicking 
Save. When you save your lighting, it 
appears as a lighting option in the 

The Apply Lighting dialog showing the 
settings to use.
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scrolling area of the dialog. If you don’t 
save your lighting, after you click OK, the 
dialog’s settings revert back to their 
preset values.

7When you are finished, click OK to apply 
your lighting. 

Before you proceed, close the image 
window. You can save it if you wish, but it 
isn’t necessary for the lesson.

Applying a Custom Tile Effect
In this exercise, you will apply a custom tile 
effect to the lighthouse, giving it a mosaic 
appearance.

To apply a custom tile effect:

1Open the color corrected photo named 
LIGHTHOUSE RETOUCHED.TIF, which 
you saved earlier in this lesson.

2Choose Effects menu> Esoterica> 
Custom Tile. The Custom Tile dialog 
appears.

Lighting effect applied to the lighthouse.
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3Set the sliders as shown below. 

4To see how different settings affect the 
tile appearance, look in the dialog’s 
Preview window as you play with the 
sliders.

5When you are finished, click OK to apply 
the tile to the image. 

The Custom Tile dialog showing the settings 
to use.

The Custom Tile effect resembles mosaics.



                                                 
5
Textures and 
Patterns
What is in this Lesson

In this lesson, you will learn how to use 
Painter to create patterns and textures. 

Painter offers many ways to use patterns, 
we will look at three: 

• Making a fractal pattern and adding it to 
the Texture library 

• Selecting a rectangular area from an 
image and capturing it as a pattern

• Defining an entire image as a pattern and 
adding it to the Pattern library. 

In Making a Background Pattern you’ll 
learn how to create a pattern, save it as a 
paper texture and apply it as a background 
to an image. Making a Seamless 
Background Pattern instructs you how to 
capture a pattern from a rectangular image 
selection and how to eliminate seams in 
tiled patterns, a technique that is useful for 
creating Web page backgrounds. 

Making a Background 
Pattern

In this part of Lesson 5, you will learn 
how to:

• Create and save a fractal pattern
• Apply the pattern to an image

• Apply surface texture to the image and to 
the paper

Creating a Fractal Pattern
Painter includes a feature called Make 
Fractal Pattern, which takes advantage of 
Painter’s powerful fractal geometry to 
create textured patterns.

Creating the Pattern

Before you begin, close any open files on 
your screen. You don’t need to have a file 
open; Painter will create one when you 
create the pattern.

To create the fractal pattern:

1Choose Art Materials palette: 
Pattern menu> Make Fractal 

Pattern. The Make Fractal Pattern 
dialog appears.

2In the Make Fractal Pattern dialog, set 
the sliders and options as shown above.

The Make Fractal Pattern dialog lets you 
design your pattern.
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As you adjust the sliders, notice that the 
Preview window updates to reflect your 
changes.

The Size option refers to how large the resulting 
pattern file will be. To get the best resolution, select 
the largest number you can. Some of the options may 
be grayed out, depending on your computer's memory 
capacity.

3When you are finished, click OK.

Painter creates a new grayscale file 
containing your pattern, at the size you 
have specified, and displays the pattern 
in a new window. 

The resulting fractal pattern is self-tiling.
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Applying Glass Distortion

Next you will apply a glass distortion to the 
fractal pattern you’ve just made.

To apply glass distortion:

1Choose Effects menu> Focus> Glass 
Distortion. The Glass Distortion dialog 
appears.

2Choose Image Luminance from the Using 
pop-up and set the sliders and options as 
shown above.

These settings give the pattern a 
petrified wood appearance.

3When you are finished, click OK. 

Use Glass Distortion to distort the pattern.
Capturing the Pattern as a Texture

Now you’ll capture (or save) this pattern as 
a paper texture, so you can apply it to an 
photographic image later in this lesson.

To capture the pattern as a texture:

1Choose Select menu> All to select the 
whole pattern.

2Choose Art Materials palette: Paper 
menu> Capture Paper. 

3In the Save Texture dialog, type a name 
for your paper texture, and click OK.

Painter saves the texture in the Paper 
Texture library and places it in the Paper 
palette drawer and on the Paper Library 
pop-up.

Painter applies the glass distortion to the 
fractal pattern.



                                                          
Applying the Paper to an Image
Continue by opening the LINCOLN.JPG 
image. You will apply your paper texture to 
this image.

To begin with the image:

1Choose File menu> Open.

2Select the LINCOLN.JPG file from the 
TUTORIAL folder in the Painter 5 folder.

3Click Open. 

Expressing a Custom Gradation

In this exercise, you’ll use Painter’s Express 
Gradation In Image feature to express a 
custom gradation into the Lincoln image. 
This feature replaces an image’s luminance 
values with the gradation’s.

Open the Lincoln image.
Before you continue, tear off the Color 
palette from the Art Materials palette, and 
move it to the lower right corner of your 
screen. (The icon of the palette you want to 
tear off cannot be selected. Click the Grad 
icon first, then drag the Color icon off the 
palette to create a second palette.) This 
way, you’ll be able to choose colors while 
you’re creating the custom gradation. 

To create a custom gradation:

1Choose Art Materials palette: Grad 
menu> Edit Grad. The Edit Gradation 
dialog appears.

For this exercise, you will create a two-
point gradation, a gradation with two 
colors: white and dark sepia.

Use the Edit Gradation dialog to set up your 
gradation. 

color 
control 
point
Be sure to set the left color control point to the darkest 
color (sepia, in this lesson) and the right color control 
point to the lightest color (white). Otherwise, when 
you express the gradation in the Lincoln image, the 
image appears in negative.

2In the dialog, click the left color control 
point, and then choose a dark sepia tone.

3In the dialog, click the right arrow, and 
then choose white from the Color 
palette. 

To add more colors to the gradation, 
click in the gradation bar to add a point, 
and then choose a new color from the 
Color palette.

To remove a point along the gradation, 
click it and the press Delete/Backspace.

Chose a dark sepia tone for the dark areas of 
the gradation. 
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Leave the Linear checkbox selected to 
create ramps that blend linearly between 
colors. 

4When you are finished, click OK.

Now you can use this gradation to express 
into the black and white Lincoln image. 

To express the custom gradation in the 
Lincoln image:

1Choose Art Materials palette: Grad 
menu> Express in Image.

The Express In Image dialog appears.

2Drag in the Preview window until 
Lincoln’s head is visible. 

3In the Express In Image dialog, set the 
Bias slider to 0%. 

You can play with the Bias slider to shift 
how the gradation is being matched to 
the image’s luminance.

Use the Preview window to determine Bias.
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4When you are finished, click OK. 

Using a Color Overlay

Now you’ll use your new paper texture to 
apply a color overlay to the image. Using a 
dark green color, you’ll give the image a 
mossy slate appearance.

To use a color overlay:

1Make sure your new paper texture is 
selected in the Art Materials: Paper 
Texture palette.

Express the two-point gradation into the 
Lincoln image.
2Choose Effects menu> Surface 
Control> Color Overlay. The Color 
Overlay dialog appears.

3In the Color Overlay dialog, choose 
Paper from the Using pop-up.

4Select Hiding Power as the Model. 

Hiding Power means the color covers 
what's beneath it. Dye Concentration 
means the paper absorbs the color.

5Choose a dark green color from the 
Color palette.

Try playing with the opacity setting. 
Watch in the Preview window to see your 
changes.

6When you are finished click OK. 

Applying Surface Texture
Notice that the Lincoln image lost some of 
its definition once you used a color overlay. 
In this exercise, you’ll compensate for that 
by applying surface texture. 

Use the Color Overlay dialog to create a 
mossy slate appearance.



First you’ll add surface texture to the image 
itself, and then to the paper. The different 
effects are achieved by choosing either 
Image Luminance or Paper from the Using 
pop-up in the Apply Surface Texture 
dialog.

Using a color overlay in the image.
Adding Texture to the Image

You will apply surface texture to make the 
Lincoln image seem like it’s part of the 
slate.

To apply surface texture to the Lincoln 
image:

1Choose Effects menu> Surface 
Control> Apply Surface Texture.

2In the Apply Surface Texture dialog, set 
the sliders and options to those shown 
below. 

3When you are finished, click OK to apply 
the texture to the image. 

Adjust the settings for applying surface 
texture to Lincoln.
Adjusting the Paper Texture

Next you’ll adjust the surface texture of the 
paper to bring out the texture in the slate 
surface.

To adjust the paper surface texture:

1Make sure the fractal pattern you saved 
as a texture is selected in the Art 
Materials: Paper palette.

2Choose Effects menu> Surface 
Control> Apply Surface Texture.

3In the Apply Surface Texture dialog, set 
the sliders and options to those shown 
below. 

After applying surface texture to the image 
using Image Luminance, Lincoln looks 
pressed into the image.
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4When you are finished, click OK to apply 
the texture. 

Adjust the settings for applying surface 
texture to bring out the slate surface.

After applying surface texture to the image 
using Paper, the slate looks real.
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Saving the Image
You’ve completed the first part of this 
lesson. Now, save the work you’ve done on 
the textured Lincoln image. Save the file as 
a JPEG (File menu> Save As) with the 
name, LINCOLN TEXTURED.JPG. Use the 
highest quality JPEG option you can.

Making a Seamless 
Background Pattern

In this part of Lesson 5, you will learn how 
to create a background pattern by 
repeating a rectangular image tile. 

A pattern is a repeating design. The smallest unit of a 
pattern is called a tile. When you fill with a pattern, the 
tile repeats across the area.

When you develop patterns, you’re creating images for 
tiling. Ideally, the images will tile seamlessly. That is, 
the eye will not be able to distinguish between tile 
edges, neither horizontally nor vertically. 

Painter provides special features to help 
you generate seamless patterns. Those you 
will use in this part of the lesson include:
• Capture a rectangular selection as a 
pattern

• Use the Soft Cloner brush to eliminate 
hard-edge seams both vertically and 
horizontally

• Use the Airbrush tool to add seamless 
painting effects

• Add your pattern to the Pattern library

• Fill a new image with your pattern

Capturing a Pattern from an 
Image Selection
Begin by opening (File menu> Open) the 
SPANISH ROOFTOPS.JPG image from the 
TUTORIAL folder.

The Spanish Rooftops image opens.



Now you will select a rectangular area to 
use as a tile, and capture (save) the pattern 
in the Pattern library

To capture a pattern from an image 
selection:

1Choose the Rectangular Selection tool 
from the Tools palette.

2With the Shift key held down, drag in the 
image to select the area to use. 

3Choose Art Materials palette: 
Pattern Menu> Capture Pattern. 
The Capture Pattern dialog appears. 

Choose the Rectangular Selection tool.

The tiled area of the image is selected.
The small Preview window displays how 
your selection will look as a tiled pattern. 
Here you can give your tile a horizontal 
or vertical shift. 

4Choose Horizontal Shift or Vertical Shift 
and adjust the Bias slider. 

Try using a 30% Vertical Shift. 

5Type a name for your pattern.

6When you are finished, click OK.

Painter saves your pattern in the Pattern 
library. Notice that it is now the current 
pattern in the Patterns palette.

The Capture Pattern dialog lets you control 
pattern offset.
Making the Pattern Seamless
If you applied your new pattern now it 
would have hard edges where the image 
from each tile meet. To make your pattern 
seamless, you can use the Soft Cloner 
brush to clone the image over the seams.

To make the pattern seamless:

1Make sure your new pattern is selected 
in the Art Materials: Pattern 
palette.

2Choose Art Materials: Pattern 
Menu> Check Out Pattern. 

A new window opens with your pattern 
in it. You may want to zoom in the 
window so you can see the details more 
closely.

3Choose the Grabber tool from the Tools 
palette.

4Hold down the Shift key, and drag in the 
image until both the horizontal and 
vertical boundaries of it are visible. 

This will let you scroll through your tiled 
pattern so you can work on the hard 
edges. 

5Choose the Brush from the Tools palette.

6Choose the Cloners brush from the 
Brushes palette.
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7Choose Soft Cloner from the Variant 
pop-up.

8Hold down the Control/Shift key and 
click in the image to set your source 
point. 

9Release the Control/Shift key and paint 
over the hard edge and make it 
disappear with a softened clone of the 
adjacent image.

You may want to repeat step seven 
through nine to redefine the source point 
for a more realistic look. 

Clone over the seams of your pattern.
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Adding Additional Effects
Your new seamless pattern looks just fine 
for a background. But, to make it more 
interesting, you can airbrush in some 
effects. Here, you’ll use the Airbrush to 
paint in some clouds.

To add additional effects with the 
Airbrush:

1Choose the Airbrush brush from the 
Brushes palette.

2Choose Fat Stroke from the Variant 
pop-up.

3Choose a white color from the Colors 
palette for the clouds.

4In the image, paint in some clouds.

Try painting beyond the edge of your 
image and notice how the stroke comes 
back around the other side. 
Saving the Pattern
Now save your pattern so you can reuse it 
later.

To save your pattern:

1Choose Art Materials palette: 
Pattern Menu> Add Image To 

Library. The Save Pattern dialog 
appears.

2Type a new name for this pattern.

If you leave the pattern name as it 
appears, Painter will replace the original 
pattern with the new one.

3Click OK. Your saved pattern becomes 
the current pattern.

Airbrush clouds into the tiled pattern.



Using Your New Pattern
Now you can use your new pattern to see 
how it will look as a background.

To use your new pattern:

1Choose File menu> New. The New 
Picture dialog appears.

2Set Width and Height to whatever you 
like.

3Click OK. A new, untitled window opens.

4Choose Effects menu> Fill. The Fill 
dialog appears. 

5In the dialog, select Fill With Pattern.

6Adjust the Opacity slider to 60%.

The Fill dialog opens.
7Click OK and the pattern fills the new 
window.

If the pattern seems to large or too small, 
you can adjust its scale using the Scale 
slider in the Pattern palette. 

To adjust pattern scale:

1Open the Pattern palette by clicking the 
Pattern icon in the Art Materials palette.

2If necessary expand the palette by 
clicking the Grow box in the upper right 
corner of the Art Materials palette.

Your pattern fills the new window.
3Drag the Scale slider to the desired scale 
percentage.

4To see the adjusted pattern in the 
window, choose Effects menu> Fill 
again.

If you intend to use your new seamless pattern as a 
background for a Web page, save the image filled with 
the pattern as a GIF file. Be sure to select the 
interlacing, transparency and other GIF file options 
that you want. 
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6
Creating 
PostScript Shapes

What is in this Lesson

In this lesson, you will learn how to create 
shapes and text in Painter. Shapes 
(including text) are vector-based objects 
that you draw, stroke and fill. With shapes, 
you can create smooth curves and lines. 
Shapes allow you the flexibility of a 
drawing program, but in the powerful 
design environment of a paint program.

This lesson uses the LINCOLN 
TEXTURED.JPG image you created in 
Lesson 5 to make a poster. In Creating a 
Shapes Image you’ll create a vector-based 
graphic of the Capitol building to use as a 
logo for the poster. In Working with Text 
you’ll add text to the poster and 
manipulate the text for an interesting 
effect.

Creating a Shapes Image

In this part of Lesson 6, you’ll create a logo 
of the Capitol building for your poster. As 
you do this, you will learn how to use:

• The Oval and Rectangular Shape tools

• The Set Shape Attributes and the Blend 
features

• The Adjuster and Shape Selection tools

• The Pen and Quick Curve tools

Creating the Shapes
The first step to creating shapes is to 
create a new file and set up the palettes.
Le
To begin creating shapes:

1Create a new, blank document by 
choosing File menu> New, and set the 
dimensions to 400 by 400 pixels at 72 
pixels per inch. Use white as the paper 
color.

2Open the following palettes by choosing 
them from the Window menu, if they are 
not already visible on your screen: Tools, 
Controls, Objects: Floater and Art 
Materials: Color palettes.

You may want to rearrange the palettes 
onscreen so they don’t overlap.

3Choose Shapes menu> Set Shape 
Attributes to set the shape attributes 
for the logo. The Set Default Shape 
Attributes dialog appears.

4Double-click the Fill color chip and 
select a golden color. If the Stroke option 
is selected, uncheck it. You will use that 
option later.

5Click OK.

Use the Attributes dialog to set shape color. 
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The Capitol building is composed of:

• One modified oval shape (the dome)

• Three rectangular shapes (the stories of 
the building)

• Two sets of vertical rectangles (for 
columns)

• Three wide, straight lines (the steps)

• A freehand object (the flag)

Creating the Dome

The dome of the Capitol is half of an oval 
shape.

To create the oval:

1Choose the Oval Shape tool from the 
Tools palette.

The Rectangular Shape and Oval Shape 
tools share a space on the Tools palette. 
You may have to click the icon that is 
visible to select the Oval Shape tool from 
the pop-up. 

Choose the Oval Shape tool. You may have 
to press down to pop it up.
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2Click in the empty window and drag 
down and to the right to create an oval.

3If you don’t like the color you set as 
default, you can change it now. Choose 
Shapes menu> Set Shape Attributes 
to display the Set Shape Attributes 
dialog. 

4Double-click the color chip to choose a 
new color and click OK. Click OK to 
dismiss the Set Shape Attributes dialog.

If you want to set this color as the new 
default, you need to repeat steps 3, 4 and 
5 from the very beginning of this lesson.

Drawing the oval shape.
As you draw the oval, the Controls palette shows its 
dimensions.

After creating the oval, notice that a Shapes Floater 
entry appears in the Floater List palette. The 
highlighted entry indicates that this object is selected. 
You’ll use the Floater List palette later in this lesson.

In Painter, shapes exist on the canvas as layers. Each 
shape occupies a different layer. The Floater List 
palette lists the shapes in layer order. 

To cut off the bottom half of the oval:

1Choose the Shape Selection tool from 
the Tools palette.

The Shape Selection tool has the hollow 
arrow icon. It shares space on the Tools 
palette with the Adjuster and Selection 
Adjuster tools. 

Choose the Shape Selection tool.



                                                             
2Starting outside the of the oval, drag 
over the lowest point to select the 
bottom anchor point. The selected point 
appears in red.

3Press the Delete/Backspace key to 
remove this point. 

Now you’ll replace the bottom of the oval 
with a straight line by joining the 
endpoints.

To join the endpoints:

1Choose the Shape Selection tool again.

2Drag over the bottom half of the oval to 
select the two bottom points.

3Choose Shapes menu> Join 
Endpoints. 

Delete the ovals’ bottom anchor point.

t

Join the ovals’ endpoints. 
Creating the Stories of the Building

In this exercise, you’ll use the Rectangular 
Shape tool to create the two stories of the 
Capitol building.

To create the stories of the building:

1Choose the Rectangular Shape tool from 
the Tools palette.

Remember that this tool shares a space 
on the Tools palette with the Oval Shape 
tool.

2Click below the dome shape and drag 
down and to the right to create the next 
story.

3Repeat step two to create the bottom 
story of the building.

Use the Rectangular Shape tool to add the 
building’s stories.
Le
Make sure the stories and the dome are 
aligned along their center points. Painter 
can do this for you, but first you must 
select each object. Holding the Shift key 
down, click each object in the Floater List 
palette. Then choose Effects menu> 
Objects> Align. In the Align dialog choose 
Horizontal: Center and click OK.

Adding the Building’s Columns

Next you’ll make the building look more 
like the Capitol by adding columns into the 
rectangular shapes.

To add columns in the top story:

1Choose the Rectangular Shape tool from 
the Tools palette.

2Draw a slender vertical rectangle inside 
the center shape along the left side.

3Choose Shapes menu> Set Shape 
Attributes to open the Set Shape 
Attributes dialog.

4Double-click the color chip, choose a 
dark green color and click OK.
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5With the column rectangle selected, 
copy and paste it to place a duplicate 
along the right side of the rectangle (Edit 
menu> Copy, Edit menu> Paste). 

Now you’ll use the Blend feature to 
automatically create evenly spaced 
rectangles between the two columns.

To use the Blend feature:

1Shift-click on both green columns with 
the Adjuster tool to select them. After 
you pasted your column, above, Painter 
automatically selected the Adjuster tool.

2Choose Shapes menu> Blend. 

3In the Blend dialog, type 3 for Number of 
Steps, and select the top Ramp Type 
option.

Create one column, copy and paste a second 
column, then move it into place.
50 Fractal Design Painter Tutorial
4Leave the other options in their default 
state, and click OK. 

Use the Blend dialog to create more shapes.

Use Blend to add three more evenly spaced 
columns between the first two.
Repeat this procedure (for the top story) to 
add columns to the bottom story. This 
time, use 5 for the Number of Steps in the 
Blend dialog.

Adding Strokes to the Shapes
Now you’ll add a stroke to the shapes of the 
building, but not to the columns. Stroking a 
shape refers to coloring a line on the 
outline path. In Painter, you stroke a shape 
using the Set Shape Attributes dialog.

To add strokes to the shapes:

1Shift-click on the three building shapes 
with the Adjuster tool to select them. 

Be careful not to select the column 
shapes; these don’t need a stroke.

Your Capitol building should look like this 
so far.

Use the Adjuster tool to select shapes.



2With the desired shapes selected, 
choose Shapes menu> Set Shape 
Attributes. The Set Shape Attributes 
dialog appears. 

3In the dialog, click the Stroke checkbox.

A black outline appears around the three 
shapes.

4To change the stroke color, double-click 
the color chip in the dialog, and choose 
the same dark green color you used for 
the columns from the color picker.

5Click OK to apply your changes. 

You can reshape the scale of your building 
parts by selecting all the elements in it and 
grabbing the edge or corner handle with 
the Adjuster tool. 

Use the Attributes dialog to set a stroke and 
stroke color for your shape.
 Drawing Straight Lines

In this exercise, you’ll use the Pen tool to 
add the steps to the base of your building.

To add the building’s steps:

1Choose the Pen tool from the Tools 
palette. 

2Click below the building where you want 
the first step to begin (to the left) and 
click again where you want it to end (to 
the right). Be careful to click abruptly, 
not drag. 

The building’s shapes with the stroke 
applied.

Use he Pen tool to create steps.
Le
3To adjust your line’s angle or length, 
select an endpoint with the Shape 
Selection tool and drag the point to make 
your changes. 

4Draw three lines to represent the capitol 
steps.

5To begin a new line, disconnect from the 
current segment by deselecting its 
endpoint. An easy way to do this is to 
hold down the Command/Ctrl key and 
click in any open area of the document. 

To change the color and thickness of the 
lines:

1Choose the Shape Selection tool from 
the Tools palette.

2Drag over all three lines to select all the 
points.

3Choose Shapes menu> Set Shape 
Attributes.

4In the Set Shape Attributes dialog, click 
the Stroke checkbox, double-click the 
color chip and choose the same golden 
color. Click OK.

5Adjust the Stroke Width slider to get the 
look you want. Click OK.
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Drawing a Freehand Shape
You’ll finish off the top of the building with 
a flag. To do this, you’ll use the Quick 
Curve tool.

To create a small box for the flag to fly 
from:

1Choose the Rectangular Shape tool from 
the Tools palette.

2Drag a small rectangle above the dome.

3Choose Shapes menu> Set Shape 
Attributes, and set a Stroke for the 
shape the same color as the other 
strokes on the building parts. Choose the 
same golden color you used for the rest 
of the building as your Fill color.

Add steps to the building.
52 Fractal Design Painter Tutorial
To create the flag:

1Choose the Quick Curve tool from the 
Tools palette.

The Quick Curve tool shares a space on 
the palette with the Pen tool.

2Draw a wavy flag shape above the flag 
stand you just created.

3To finish the shape, draw over the point 
from which you started. The shape fills 
with color. 

Add the flag stand with the Rectangular 
Shape tool.

Use the Quick Curve tool to draw the flag.
4If you miss the starting point or need to 
interrupt your stroke, click the red 
endpoint and pick up where you left off. 
If you’re close enough, click the Close 
button on the Controls palette to 
complete the shape.

5Apply a stroke to the new shape.

You may want to edit the flag’s shape. You 
can add a point, remove a point or create a 
curve point with the Shape Edit tools. 

To adjust the wavy lines:

1Choose the Shape Selection tool from 
the Tools palette.

2Drag any anchor point to improve the 
curves.

3Move several points, if necessary. Select 
them by dragging around them or Shift-
clicking them one by one.

The Shape Edit tools share a common space 
on the Tools palette.



4If the line has extraneous anchor points, 
choose the Remove Point tool and click 
the points you want to remove. 

Now you have all the elements finished for 
the logo. In the next part, you’ll put 
together your poster using this logo and 
adding text and effects. 

Saving the Image
You’ve completed the first part of this 
lesson. Save the file as a RIF (File menu> 
Save As) with the name, CAPITOL 
LOGO.RIF. 

Delete an anchor point, if necessary.
Working with Text

In this part of Lesson 6, you will learn how 
to create and manipulate text. As you do 
this, you’ll learn how to use: 

• The Text tool

• The Floater List palette

• The Apply Surface Texture feature

Begin now by opening the LINCOLN 
TESTURED.JPG image that you saved from 
Lesson 5. 

Before you proceed to add text, you need 
to create a rectangular shape at the bottom 
of the image. The text and the logo you 
created appears on this rectangular 
background.

The LINCOLN TEXTURED.JPG image.
Le
To create the rectangular background 
for the text and the logo:

1Choose the Rectangular Shape tool from 
the Tools palette.

2Drag to create the rectangular shape.

3Choose Shapes menu> Set Shape 
Attributes to open the Set Shape 
Attributes dialog. Choose a dark green 
Fill color and click OK.

Adding Text
Now you’ll type in three groups of text at 
the bottom of the Lincoln image.

To add text:

1Choose the Text tool from the Tools 
palette.

2Choose a color for your text from the 
Color palette.

Try using the same golden color you 
used for the Capitol building parts.

You will add text over this rectangular shape.
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3In the Controls palette: Text tool, 
use the Font pop-up to choose Other 
Font. The Choose Font dialog appears.

4Select a font, such as New York or Arial, 
and click OK.

5In the Controls palette: Text tool, 
use the Point Size slider to change the 
size of the font to 12 point.

6Click inside the rectangular background 
and type Washington D.C.

7Now click just above the rectangular 
background you created earlier.

8Type Capitol Tours.

9To add the headline, click about a third 
of the way down from the top of the 
poster to set the text insertion point.

ºChange the point size to 36 on the 
Controls palette.

Chose Other Fonts from the Font pop-up.
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¡Type Lincoln, press Return/Enter to 
start a new line, and type Memorial. 

Notice that the Objects: Floater List 
palette lists each individual letter for all of 
your words as a separate shape. 

Your text should look like this.

The Floater List palette lists each letter as a 
separate shape.
Manipulating Text
After you finish typing in the text, you’ll 
also scale one line of text to give it a 
different look. Before manipulating text, 
you should group all the letters of a word 
or set of words together, so you can 
manipulate them as one unit.

Painter treats text as Shape objects. So, when you 
manipulate text, you adjust each letter of text as an 
individual vector-based object.

To group text:

1Choose the Adjuster tool from the Tools 
palette.

2Drag around the Lincoln Memorial 
words to select them.

3Click the Group button in the Objects: 
Floater List palette.

Repeat this procedure to group together 
the letters that form the words Capitol 
Tours. Do it again to group together 
Washington D.C. but be careful not to 
group the green bar with the text. When 
you are finished, you should see three 
groups listed in the Objects: Floater List 
palette. 



To scale text:

1With the Capitol Tours group of words 
selected, Position the Adjuster tool on 
the edge or corner of the selection. You 
will see the cursor change to indicate 
you can scale the text.

2Drag to the right to the stretch the 
letters.

You can experiment with scaling text up, 
down, left, right or any direction you want. 
To maintain proportions, hold down the 
Shift key as you drag.

Three groups of text are listed in the Floater 
List palette.
Adding the Logo
Now you’ll add the logo you created at the 
beginning of this lesson to the poster.

To add the logo:

1Open your Capitol logo file—CAPITOL 
LOGO.RIF.

2Use the Shape Selection tool to select all 
the elements of your Capitol. Drag over 
the objects or Shift-click them in the 
Floater List palette.

3Group them by clicking the Group 
button in the Objects: Floater palette.

4Choose Edit menu> Copy.

5Open the Lincoln image and choose 
Edit menu> Paste.

You’ll have to scale the logo down to fit in 
your composition.

To scale the logo:

1Select the grouped Capitol. 

2Using the Adjuster tool, drag the upper 
right corner of the grouped selection 
down and to the left to reduce it’s scale.

3Hold down the Shift key while you drag 
to maintain the aspect ratio. 
Le
After scaling, you’ll probably want to re-
adjust your shape line weights by using the 
Shapes menu> Set Shape Attributes 

dialog. 

Adding Surface Texture to Text
In this exercise, you will apply surface 
texture to the Lincoln Memorial grouped 
text so it looks as if these words are 
chiseled in stone. Before you can apply 
surface texture to text, you must convert 
shape objects to floaters.

To convert shapes to floaters:

1Use the Adjuster tool to select the 
Lincoln Memorial grouped text.

2Choose Shapes menu> Convert To 
Floater (you may also click the Collapse 
button on the Floater List palette).

After adding text and the logo, your 
composition should look similar to this.
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Now that the text is converted to a floater, 
it has its own mask. First you’ll apply 
texture to the text and then you’ll use its 
mask to apply a chiseled effect.

To apply surface texture to the text:

1Make sure the Lincoln Memorial floater 
is selected.

2Make sure the Basic Paper texture is 
selected in the Art materials: Paper 
palette.

3Choose Effects menu> Surface 
Control> Apply Surface Texture.

The Apply Surface Texture dialog 
appears. 

The Apply Surface Texture dialog with 
settings for textured text.
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4In the Apply Surface Texture dialog, set 
the sliders and options as shown, and 
click OK.

Next apply depth to the letters to give a 
chiseled effect.

To chisel the text:

1Make sure the Lincoln Memorial floater 
is still selected.

2Choose Effects menu> Surface 
Control> Apply Surface Texture.

3In the Apply Surface Texture dialog, 
choose the text’s mask from the Using 
pop-up.

This option appears as Group 2 Mask (or 
similar) at the end of the pop-up.

4Set the sliders and other options as 
shown. 

5When you are finished, click OK to apply 
the chiseled effect to the text.
Saving the Image
Your poster is now complete and should 
look similar to the one shown here. Be sure 
to save you work (File menu> Save) 

The Apply Surface Texture dialog with 
settings for chiseled text.

Your finished poster looks like it was 
chiseled in stone.



                                          
7
Selections and 
Masks
What is in this Lesson

Before you can work with a specific part of 
an image, you must first select it. Painter 5 
gives you flexibility and control in making, 
editing and saving selections. A selection 
marks off areas of the canvas for “special 
treatment.” The selection may protect an 
area from change or describe the area that 
you want to change. 

To extend your capabilities for working 
with selections, Painter lets you save 
selections as user masks. A user mask is 
like a stencil—it lets you work on selected 
areas of an image or edit the mask like you 
would an image, with the Brush tool and 
image effects. You can store multiple user 
masks in the Mask List palette and load 
them later as selections.

Selections and masks in Painter 5 work much like 
selections and masks in Adobe Photoshop. With 
similar menu commands and palette controls, it’s easy 
to move between Painter and Photoshop.

This lesson teaches you how to create and 
use selections and masks in Painter. You’ll 
learn how to:

• Generate selections from specific areas of 
an image
• Save selections as masks

• Combine selections to generate masks

• Paint a mask

• Use floater visibility masks

• The end of this lesson gives you brief 
information on applying effects to a 3D 
mask, exported from Ray Dream Studio.

Generating Selections and 
Masks

In this part of Lesson 7, you will learn how 
to use a variety of methods to generate 
selections and masks, including:

• Using the Lasso tool

• Using the Magic Wand tool

• Using the Oval Selection tool

• Saving selections as masks
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You can generate a selection in several ways—by 
using one of the Selection tools (Rectangle, Oval or 
Lasso), using the Magic Wand tool, choosing a 
command (Auto Select or Color Select), using a 
Shape tool (Pen, Quick Curve, Rectangular Shape 
or Oval Shape) and converting the shape to a 
selection, or creating a mask and loading it to the 
selection. For more information, refer to Chapter 9, 
”Selections and Masks” in the Painter 5 User Guide.

Begin the lesson by opening the STATUE OF 
LIBERTY.JPG file from the TUTORIAL 
folder. 

Using the Lasso Tool
The Lasso tool is one of the Selection tools. 
You use it to generate freehand selections. 
In this exercise, you’ll use the Lasso tool to 
select only the statue in the image.

You’ll use the Statue of Liberty file for this 
lesson.
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To make a selection with the Lasso tool:

1Extend the image window enough to 
show the grey boundary area beyond the 
canvas.

2Choose the Lasso tool from the Tools 
palette. 

3In the image, position your stylus near 
(but not on) the edge of the statue itself, 
and draw around the statue to select it.

You don’t have to be extremely precise. 
Just make sure you select the whole 
statue. If you need to, draw in the 
boundary area to make sure you get all of 
the base. 

4End your selection stroke near the start 
of your stroke to complete the circle. 

Choosing the Lasso tool.
The selection closes automatically. 

Masking a Selection

You can determine how a selection is 
masked by using the drawing mode 
buttons. The drawing mode buttons 
determine whether the inside or outside of 
a selection is masked when you paint on an 
image. 

To mask the outside of the selection:

1Press on the Drawing Mode Button icon 
in the lower left corner of the image 
window to show the drawing mode 
buttons.

When part of an image is selected, 
“marching ants” appear around the 
selection.



                                                            
2Select the Masked Outside mode (the 
one on the far right).

In this mode, only the masked region 
(the statue, in this case) accepts brush 
strokes. 

3From the Brushes palette, choose an art 
tool like Chalk and draw over your 
selected area to see that you are in the 
masked outside mode.

4Masked Outside mode means that you 
can modify the outside of the selection, 
but the inside is protected from changes.

Choose the Mask Outside mode from the 
drawing mode buttons.

The mask is outside of the selected area.
To mask the inside of the selection:

1Choose Edit menu> Undo to remove 
your previous strokes. 

2Select the Masked Inside button (the 
middle one).

3Draw again to see that the strokes are 
only outside the selection. 

4Choose Edit menu> Undo to remove 
your strokes, but leave your selection 
intact.

When you select the left button—Mask Disabled, 
the mask is turned off and you can draw anywhere in 
the image.

The mask is inside of the selected area.
Applying Effects Using Masking

You can apply effects to specific areas of an 
image using masking. In this exercise, you 
will apply a fill pattern and posterize the 
masked area of your selection.

Begin by selecting the Masked Outside 
drawing mode button. You will apply the 
effects to inside of your selection, leaving 
the outside masked (protected). 

To apply a fill pattern to inside of your 
selection:

1Choose a pattern to use from the Art 
Materials: Pattern palette. 

2Choose Effects menu> Fill. The Fill 
dialog appears.

3Select Fill With Pattern and click OK. 

Selecting a fill pattern.
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To posterize the inside of your selection:

1Choose Edit menu> Undo to remove 
your previous fill effect.

2Choose Effects menu> Tonal 
Control> Posterize. The Posterize 
dialog appears.

3Type 4 in the Levels box and click OK. 

Applying the fill pattern.

Posterizing the selection.
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4Choose Edit menu> Undo to remove 
your effect, but leave your selection 
intact.

Saving a Selection as a Mask

You can save the current selection to 
create a mask. This way, you save the 
selection for later use or for more editing 
control available in a mask.

To save your selection as a mask:

1Make sure your selection is still active.

Remember that “marching ants” indicate 
an active selection.

At any moment, there may be only one selection. 

2Make sure the Objects palette is visible. If 
it isn’t, choose Window menu> Show 

Objects.
3Click the Mask icon in the Objects palette 
to show the Mask List. 

4Click the Save Selection button in the 
Objects: Mask List palette. The Save 
Selection dialog appears.

5Choose New from the Save to pop-up and 
select Replace Mask.

6Click OK. 

The Objects: Mask List palette.

The Save Selection dialog appears.



Painter creates a new mask based on the 
selection and adds it to the Objects: 
Mask List palette as New Mask 1. 

Painter gives you many ways to create masks—by 
saving a selection as a mask, by creating a new blank 
mask, by creating an Auto Mask, by creating a Color 
Mask, or by copying an existing mask.

To rename the mask:

1Double-click New Mask 1 in the 
Objects: Mask List palette. The Mask 
Attributes dialog appears.

The new mask appears in the Objects: Mask 
List palette.
You can also open this dialog by 
choosing Objects palette: Mask 

menu> Mask Attributes. 

2Type Lasso as the new name, leave all 
other options as is, and click OK.

Now only the mask layer is visible, as 
indicated by the Eye icon. The Lasso 
mask layer is exposed as a solid black 
mask without the RGB information 
visible.

Each item in the Mask List shows an Eye icon to the 
left of it. The Eye icon controls whether or not the RGB 
image or any mask is visible. When the Eye is open, 
the item is visible. When the Eye is closed, it’s hidden 
(not displayed).

3To make the RGB information visible 
again, click the RGB-Canvas item in the 
Objects: Mask List palette. This 
makes that layer visible.

The Mask Attributes dialog appears.
Note: If the selection is still active after you 
save it as a mask, choose Select menu> 
None to deselect the active selection.

Using with the Magic Wand Tool
Another way you can make a selection is by 
using the Magic Wand tool. This tool works 
by selecting a contiguous area based on the 
color of pixels.

Next you’ll use the Magic Wand tool to 
select the sky blue area around the Liberty 
statue. Then you’ll save your selection as 
another mask.

Selecting with the Magic Wand Tool

To make a selection using the Magic 
Wand tool:

1Make sure the RGB-Canvas layer is 
selected in the Objects: Mask list 

palette.

2Choose the Magic Wand tool from the 
Tools palette. 

3In the image window, click in the sky area 
and drag a bit to select the sky color 
area. 

Choosing the Magic Wand tool.
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The Magic Wand tool has a dynamic tolerance 
setting. That means that the higher the tolerance 
setting, the more colors Painter selects with the Magic 
Wand. The lower the tolerance, the fewer colors 
selected. You set tolerance level in the Controls 
palette and it will update in real time.

4Now play with the Tolerance slider in the 
Controls palette to select a wider or 
narrower group of similar colors. As you 
increase tolerance to more colors, you’ll 
select inside the statue.

Painter selects the entire area around the 
Liberty statue.
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5To restrict the selection so it outlines the 
statue as closely as possible, set the 
Tolerance to about 6. 

Saving the Selection as a Mask

Now save your selection as a new mask.

To save the selection as a mask:

1Click the Save Selection button in the 
Objects: Mask List palette. The Save 
Selection dialog appears.

2Choose New from the Save to pop-up 
and select Replace Mask. 

3Click OK to save the selection.

Follow the steps described earlier for using 
the Mask Attributes dialog to rename the 
new mask. Give the mask the name Sky.

Tolerance affects how much color is selected 
with the Magic Wand tool.
Using the Oval Selection Tool
In this exercise, you’ll use the Oval 
Selection tool to make a selection around 
the head and torso area of the statue.

To make a selection with the Oval 
Selection tool:

1Select the RGB-Canvas layer in the 
Objects: Mask List palette.

2Choose the Oval Selection tool from the 
Tools palette. 

The Objects: Mask List palette lists your two 
masks.

Choosing the Oval Selection tool.



The Oval Selection tool shares a space 
on the Tools palette with the Rectangular 
Selection tool, so you may have to pop 
up the icon to select the oval.

3Drag an oval around the statue’s head 
and torso to make the selection. 

4Choose the Selection Adjuster tool from 
the Tools palette. 

5Use the Selection Adjuster tool to move 
or resize the selection to your liking.

Selecting the head and torso.

The Selection Adjuster tool.
6Click the Save Selection button in the 
Objects: Mask List palette. The Save 
Selection dialog appears.

7Save you selection as a New mask with 
the Replace Mask option and click OK.

8Rename this new mask Oval. 

Painter lets you create up to 32 user masks in a 
document. 

The Objects: Mask List palette lists all three 
of your masks.
Combining Selections to 
Generate New Masks

With several selections saved as mask, you 
can combine them to create additional 
unique masks. In this section of Lesson 7, 
you’ll learn how to load selections and how 
the Add To, Subtract From and Intersect 
With operations function in the Save 
Selection dialog.

Painter stores masks in the Objects: Mask 

List palette. When you’re ready to use one of 
them, you load it onto the image as a selection.

Loading a Selection
To use a saved selection, you must first 
load it onto the image.

To load a selection:

1In the Objects: Mask List palette, 
click the Load Selection button. The 
Load Selection dialog appears.

2Choose Lasso from the Load From 
pop-up and select Replace Selection. 

3Click OK.
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The Lasso selection becomes active in the 
image, as indicated by the marching ants 
around the statue.

Subtracting One Selection from 
Another
In this exercise, you’ll subtract one 
selection from another to create a more 
accurate selection. You’ll use your Sky 
selection to turn the Lasso selection into an 
accurate selection of the statue.

To subtract one selection from another:

1Make sure the Lasso selection is still 
active.

2In the Objects: Mask List palette, 
click the Load Selection button. The 
Load Selection dialog appears.

3Choose Sky from the Load From pop-up, 
and select Subtract From Selection.

The Load Selection dialog.
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4Click OK. 

Subtract From Selection removes the 
loaded mask (Sky) from the current 
selection (Lasso). In other words, the mask 
“cuts away” from the selection. Now save 
this selection for later use.

To save this selection:

1Click the Save Selection button in the 
Objects: Mask List palette. The Save 
Selection dialog appears.

2Choose New from the Save to pop-up and 
select Replace Mask.

3Rename this new mask Liberty.

The result is a selection of the statue alone. 
Adding to a Selection
Now you’ll combine the Oval and the 
Liberty selections to create new mask that 
is a selection of the statue combined with 
the outline of the oval.

To add to a selection:

1In the Objects: Mask List palette, 
click the Load Selection button. The 
Load Selection dialog appears.

2Choose Liberty from the Load From 
pop-up, select Replace Selection.

3Click OK.

4Liberty becomes the active selection.

5Click Load Selection again.

6This time choose Oval from the Load 
From pop-up, select Add To Selection. 
This options adds the Oval mask to the 
current selection. 



7Click OK.

Intersecting Two Selections
Next you’ll intersect the Liberty selection 
with the Oval. The result is a selection of 
the negative space defined by the statue’s 
outline within the oval.

1In the Objects: Mask List palette, 
click the Load Selection button. The 
Load Selection dialog appears.

2Choose Liberty from the Load From 
pop-up, select the Replace Selection.

3Liberty becomes the active selection.

4Click Load Selection again. 

5This time, choose Oval from the Load 
From pop-up, select Intersect With 
Selection.

The result is a selection of the statue 
combined with the outline of the oval. 
6Click OK.

Intersect with Selection determines the 
intersection of the mask and the current 
selection. This intersection becomes the 
new selection. 

Painting a Mask

In this part of the lesson, you’ll create a 
new mask and then paint it with a brush.

Begin by opening the SPHINX.JPG image in 
the TUTORIAL folder.

The result is a selection of the negative space 
defined by the statue’s outline within the 
oval.
Creating a New, Blank Mask
You can create a new, blank mask by 
choosing Objects palette: Mask menu> 

New. With a blank mask, you can use any 
of Painters painting and editing techniques 
to develop imagery in it. 

To create a new mask:

1Make sure the Objects: Mask List 

palette is visible. If it isn’t, choose 
Window menu> Show Objects and 
click the Mask icon in the palette.

2Click the New button in the Objects: 
Mask List palette.

Painter adds a new mask to the Mask List. 
The new mask is blank; it doesn’t contain 
any data in it. To see it, close the Eye icon 
of the RGB-Canvas layer, and you’ll see a 
blank screen. Click the Eye icon again to 
make the RGB-Canvas layer invisible.

Anything you paint or draw or create with 
the new mask active will become part of it. 
Painter will use that data to mask the image 
behind it.

Painting the Mask
With the new mask created, you’ll use a 
brush to paint the mask.
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To paint the mask:

1Make sure the new mask layer you just 
created is highlighted in the Objects: 
Mask List palette.

2Choose the Brush tool from the Tools 
palette.

3Choose the Chalk brush from the 
Brushes palette.

4Choose Artist Pastel Chalk from the 
Variant pop-up.

5Paint in the head of the Sphinx to mask 
that area.

Reduce the size of the brush to mask the 
edge of the image with more precision.

Painting the Sphinx’s head to mask it.
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Saving the Image with a Mask
Now save your work. You will use this 
image later in Lesson 8.

To save the image with the mask:

1Choose File menu> Save As.

2Name the file SPHINX MASK HEAD.TIF 
and select a destination folder.

3Select the TIF file format, and click OK.



                                             
8
Floaters

What is in this Lesson

In this lesson, you will learn how to work 
with floaters. Floaters are images, or 
portions of images, that float above the 
canvas. Each floater is a separate image, so 
each floater you add to an image 
introduces another layer of information. 
Because each floater is distinct, you can 
move, change and reapply them without 
interfering with the original canvas image—
or other floaters. Likewise, you can work in 
the canvas without interfering with any of 
the floaters.

Painter 5 introduces new, sophisticated 
type of floaters called Dynamic Plug-in 
Floaters. Unlike traditional image layers 
that let you collage static image elements, 
Dynamic Plug-in Floaters perform image 
processing effects (like burning and 
tearing) that update automatically. You can 
also create new objects like a liquid metal 
painting layer. 

In Working with Floaters to Create a 
Collage you’ll learn the basics of working 
with floaters, including how to create and 
manipulate them. In Using Dynamic Plug-in 
Floaters you’ll learn how to apply amazing 
effects and create new floaters using 
Dynamic Plug-in Floaters.

By the time you finish this lesson, you will 
have collaged several floaters and Dynamic 
Plug-in Floaters into a travel poster. 

Working with Floaters to 
Create a Collage

In this part of Lesson 8, you’ll learn how to 
use floaters to create a collage. As you do 
this, you will learn how to:

• Create a floater for use as the background 
and modify it
• Add floaters from the Lesson 8 Floaters 
Library

• Create a floater from scratch

• Paint on a floater.

Creating the Background
To begin your collage, you’ll create a 
background from a floater; then you’ll 
modify it to look like parchment paper, so it 
resembles a treasure map.

To create the background floater:

1Create a new file that is 400 pixels x 550 
pixels and 72 ppi.

2Choose Window menu> Zoom to Fit 
to optimize the window for your screen.

3Extend the corner of the canvas window 
out so you can see the edge of the 
canvas.

4Choose Select menu> All to select the 
entire canvas.

5Choose the Adjuster tool from the Tools 
palette, and then click in the selected 
area.

Use the Adjuster tool to select an area.
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This creates a floater that is the size of 
your canvas. The yellow and black 
border indicates it is a floater.

6Open the Objects: Floater List 
palette by choosing Window menu> 

Show Objects and clicking the Floater 
icon in the Objects palette. 

7Rename the floater by double-clicking its 
name in the Objects: Floater List 
palette. Name the floater Parchment.

At this point, your background doesn’t 
contain any imagery at all, you’ve just 
designated it as a floater and named the 
floater. Next you’ll transform this floater 
into a piece of parchment paper to use as a 
background.

You’ll see the floater you just created listed in 
the palette.
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To modify the floater:

1Make sure the Parchment floater is 
selected.

2Choose the Hand Made paper texture 
from the default paper textures in the 
Art Materials: Paper palette. 

3Expand the Art Materials: Paper 
palette and set the Scale slider to the 
maximum.

4In the Color palette, choose a tan or 
parchment color.

5To apply the paper texture and color to 
the floater, choose Effects menu> 
Surface Control> Color Overlay.

6In the Color Overlay dialog, choose 
Paper from the Using pop-up, set Opacity 
to 100% and select Dye Concentration. 

Scale the paper texture up so it is very large.
7Click OK. 

Adding Floaters
Now that the background for your 
“treasure map” is set, you’ll add several 
floaters to it. To do this, you’ll use floaters 
stored in the Lesson 8 Floaters Library—a 
special floater library provided in the 
TUTORIAL folder specifically for this 
lesson. You’ll also use the mask you saved 
in Lesson 7. If you did not go through 
Lesson 7, or save the “Sphinx masked” file, 
you will need to do that now, or skip that 
part of this lesson.

Your parchment paper should look similar 
to this.



                                                                       
Adding Floaters from a Library

Start bringing in floaters to create your 
composition.

To open the Poster Floater Library:

1Choose Objects: Floater menu> 
Floater Portfolio. The default Floater 
Portfolio appears. 

2Choose Load Library from the Floater 
Library pop-up at the bottom of the 
Floater Portfolio. 

3Locate the Lesson 8 Floaters Library in 
the TUTORIAL folder and click Open.

Painter loads the floaters stored in the 
special library into the Floater Portfolio. 
Now you can add the floaters.

To add the first floater:

1In the Floater Portfolio, locate the floater 
called Fractal Travel. You may have to 
choose it from the Floater Library 
pop-up.

2Drag it onto your canvas near the top. 

This will become the poster’s headline. To 
jazz it up a little, you can fill it with a 
gradation using one of Painter’s image 
effects. You can apply most items in the 
Effects menu to active floaters, including 
the distortion and scaling.
To fill the floater with a gradation:

1Open the Gradations palette by clicking 
the Grad icon in the Art Materials 
palette.

2Choose Sunset from the Grad pop-up.

3Move the indicator in the Grad Angle 
Ring to change the gradation so it is 90˚ 
horizontal (the red dot is at the top).

Adding the headline.
4With the Fractal Travel floater selected, 
choose Effects menu> Fill. The Fill 
dialog appears.

5Select Fill With: Gradation and click OK.

To apply a surface texture to the Fractal 
Travel floater:

1Choose Effects menu> Surface 
Control> Apply Surface Texture. 
The Apply Surface Texture dialog 
appears. 

2Choose Fractal Travel Mask from the 
Using pop-up and play with the Softness 
and Amount sliders to give the lettering 
some depth. 

Setting the gradation.
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3When you’re satisfied with your result, 
click OK. 

Every image floater has its own mask, which defines 
the image shape and opacity. The floater that is 
highlighted in the Floater List palette is the active 
floater.

Now add three more floaters from the 
Lesson 8 Floaters Library. 

To add the remaining floaters from the 
library:

1Drag the Liberty, Arch and Jet floaters 
onto your canvas in any order or 
position you want.

When you are finished, you’re headline 
should look similar to this.
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2To scale, rotate or slant a floater, select 
one and choose Effects menu> 
Orientation> Free Transform.

Free Transform lets you make fast 
adjustments to your floater by creating a 
low resolution version for you to work 
with. You must commit your transform 
to restore the high resolution version 
again.

3Transform the floaters to your liking. 
When you are finished, choose Effects 
menu> Orientation> Commit 

Transform.

Adding the Sphinx Mask as a Floater

In this exercise, you’ll use the Sphinx mask 
you saved in Lesson 7 as a floater. If you 
did not complete this lesson, do so now or 
skip this part of Lesson 8.

To use the mask as a floater:

1Choose File menu> Open and select 
the SPHINX MASK HEAD.TIF file that you 
saved from Lesson 7 when you masked 
the Sphinx.

2Click the Mask icon in the Objects palette 
to open the Mask List palette.

3Select the mask that you created of the 
Sphinx head.

You are going to load the mask as a 
selection and float it.
4Click the Load Selection button in the 
Objects: Mask List palette.

5In the dialog, choose whatever you 
named the mask from the Load From 
pop-up and select Replace Selection.

6Click OK. 

7With the Adjuster tool, click in the 
selected area to float it. 

8To open the Floater List palette, click the 
Floater icon in the Objects palette.

9Click Trim to trim the floater’s borders 
as close as possible to the floater. 

ºWith the floater selected, copy the 
floater (Edit menu> Copy). 

¡Switch to your travel poster canvas file, 
and paste the floater (Edit menu> 
Paste).

The masked area is now selected so it can be 
loaded as a selection.



Notice that as you introduce each new floater, its 
name appears in the Floater List palette in the order 
you layered them onto the canvas. The floater at the 
top of the list floats above all the others; the second 
floater floats behind the first but above the rest; and 
so on. You can change overlap order by clicking the 
name of the floater you want to move and dragging it 
up or down in the Floater List palette.

Experiment with dragging the floaters 
around the canvas to position them as you 
like. As you do, you may want to change the 
overlap order. You can also transform the 
floaters using the Effects menu> 
Orientation> Free Transform feature.

The Controls palette: Adjuster tool 
also gives you flexibility in how floaters 
composite into the scene. To change the 

Copy and paste the sphinx head to add it to 
the poster.
composite method, select an item from the 
Composite Method pop-up in the Controls 
palette. For example, try choosing 
Luminosity or Saturation. 

Creating a Floater from Scratch
In this part of the lesson, you’ll learn how 
to create a new floater from scratch. You’ll 
use it to make an “X” in the poster, as if to 
indicate where the treasure lies.

To create a floater from scratch:

1Create a new file that is 100 x 100 and 
72 ppi. 

2Choose the Brush tool from the Tools 
palette.

3Choose the Chalk brush from the 
Brushes palette.

4Choose Sharp Chalk from the Variant 
pop-up.

5Choose a dark color, like black, from the 
Color palette.

The Controls palette lets you select a 
composite method.
6In the small blank canvas, brush with 
your stylus to draw a bold treasure map 
kind of “X.” 

7To move this onto your poster canvas, 
choose Select menu> All, copy the 
selection and then paste it onto the 
poster.

The entire image appears as a floater. 

8Resize it to your liking. Choose Effects 
menu> Orientation> Scale. Type a 
scale percentage and click OK.

9To hide the white background, in the 
Controls palette: Adjuster tool, 
choose Gel or Darken from the 
Composite Method pop-up.

Note: If you want the background of a 
floater to be truly hidden, you must mask 
it. To do this, return to your ‘X’ file and 
choose the Magic Wand tool. Click on the 
black ‘X’, then copy and paste it into your 
poster file.

Create the “X” for “X marks the spot.”
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Painting on a Transparent 
Floater
In addition to applying effects to an active 
floater, you can paint on any floater. 
Painter 5 even lets you paint on a 
transparent floater. 

Now turn your composition into a real 
“treasure map,” complete with a dotted line 
connecting to all the floaters and ending at 
the “X” you just made.

To paint on a transparent floater:

1Choose Objects palette: Floater 
menu> Transparent Layer.

To paint on a transparent floater, you need to create 
the layer first, then use a brush that takes advantage 
of this feature. You can use the Layer brushes in the 
New Brushes folder in your Painter 5 folder. You can 
also use any brush by first changing its Method and 
Method Subcategory.

2Choose the Brush tool from the Tools 
palette. 

3Choose the Chalk brush from the Brush 
palette.

4Choose Sharp Chalk from the Variant 
pop-up.
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5Click the Zoom box to expand the 
Brushes palette. Set the Method to Plug-
in and the Subcategory to Transparent 
Layer Brush.

6Choose a dark color from the Color 
palette.

7To draw the dotted line, start close to 
the top of your canvas and draw a dotted 
line, stopping at each of your elements 
and ending up at the “X.”

Because you are painting on a 
transparent floater, you can move the 
lines around by dragging that floater 
with the Adjuster tool. Use the Floater 

Expand the Brushes palette and set the 
Method to Plug-in and the Subcategory to 
Transparent Layer Brush.
List to arrange which floaters are above 
the transparent floater and which 
floaters are underneath it.

Saving the Image
You’ve completed the first part of this 
lesson. Before you continue, save your 
work. Save this file as a RIFF (File menu> 
Save As) using the name FLOATER 
COLLAGE.RIF. By saving as a RIFF file, you 
preserve the flexibility of your floating 
objects. Many other formats will flatten the 
image. 

Paint the dotted line on the transparent 
floater.



Using Dynamic Plug-in 
Floaters

In this part of Lesson 8, you will learn how 
to use Dynamic Plug-in Floaters to apply 
special effects. The Painter features you’ll 
use in this part of the lesson include the:

• Impasto Plug-in Floater

• Burn Plug-in Floater

• Liquid Metal Plug-in Floater

• Drop Shadow effect

• Bevel World Plug-in Floater

To access Painter’s Dynamic Plug-in 
Floaters:

1Make the Objects palette visible by 
choosing Window menu> Show 

Objects.

2In the Objects palette, click the P. Float 
icon. 

The plug-in floaters appear in the P. Float 
palette and in the Library pop-up.
Creating a Wrinkle Effect
Every good treasure map seems to be 
wrinkled and have burnt edges. It just so 
happens that Painter can generate both 
effects through its Dynamic Plug-in 
Floaters.

To create a wrinkle effect in the poster:

1Make sure you have your FLOATER 
COLLAGE.RIF image open in Painter.

2With Parchment as your active floater, in 
the Objects palette click the P. Float icon 
to access the plug in floaters. 

3In the Objects: P. Float palette, 
choose Impasto from the pop-up, and 
click Apply. The Impasto Options dialog 
appears.

The Impasto Options dialog appears. 
Each Plug-in Floater has its own options dialog. As you 
make changes in the dialog, the selected floater 
updates accordingly in the image. That is, the settings 
are dynamic; your changes occur immediately and can 
be changed, even after you close the dialog, until you 
commit your changes to the floater.

Impasto allows you to paint with texture 
and depth. So its options let you specify 
color, depth, opacity, light controls and 
so on.

4Select only the Draw With Depth and 
Opacity Controls Depth options. Set the 
How Depth Is Drawn option to Paper. 

5Choose the Airbrush from the Brushes 
palette. 

6Choose Fat Stroke from the Variant 
pop-up. 

When a Plug-in Floater options dialog is open, you 
can still access items in the Art Materials and 
Brushes palettes.

7Paint on the parchment and watch the 
texture rise from the paper. 
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8Repeat your stoke and adjust the size in 
the Controls palette to build up a 
wrinkled look.

9When you are finished, click OK. 

Impasto is unique because you can work 
with or without the dialog open.

Notice that the Parchment floater now 
shows a Plug-in Floater icon next to it in the 
floater list. To open the options dialog 
again and re-adjust the effect, double-click 
the floater name.

The poster has a “wrinkled” effect applied.
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Applying a Burn Effect
Next, you’ll apply a burn effect to the edges 
of the parchment. To do so, you’ll apply 
another plug-in floater to the same floater. 

To apply a burn effect:

1With the Parchment floater selected, 
choose Burn from the Plug-in Floater 
Library pop-up.

2Click Apply. 

3Click Commit in response to the 
message.

4Adjust the Burn options to your liking, 
and click OK. 

The Burn Options dialog appears.
Since Painter only allows one effect to 
remain dynamic at a time, you will be 
asked to commit the first effect 
(Impasto) to the floater when you apply 
the burn effect.

Using the Liquid Metal Plug-in 
Floater
One of the coolest Dynamic Plug-in Floaters 
to come with Painter 5 is Liquid Metal. 
Liquid Metal is useful for many effects, 
including simulating water. In this exercise, 
you’ll use it to paint some waves in the 
lower part of the poster.

Plug-in floaters create their own floater to 
work on if none is selected. To see how this 
works, you’ll let Liquid Metal create its own 
floater.

The burn effect applied to the poster.



To use the Liquid Metal plug-in floater:

1In the Objects palette, click the Floater 
icon and click in the open area below the 
floater list to deselect the Parchment 
floater.

2Click the P. Float icon in the Objects 
palette.

3Choose Liquid Metal from the Plug-in 
Floater Library pop-up and click Apply. 

4In the Liquid Metal dialog, select 
Standard Metal as the map. Try painting 
over some of the detail in the poster 
image, and turn up the Refraction slider. 

Notice that the underlying image refracts 
through the brush strokes.

5When you like your waves, click OK to 
dismiss the Liquid Metal options dialog.

The Liquid Metal dialog appears.
6To add a small boat to your “waves,” 
click the Boat floater in the Floater 
Portfolio and drag it onto the Liquid 
Metal effect you just painted. 

Now is a good time to look at your 
composition and make any changes. All of 
the items in your poster are still floaters, so 
they can still be changed individually 
without effecting the overall image.

Liquid Metal and new boat floater applied.
Adding a Drop Shadow
To give the headline of your poster some 
pizzazz, you can add a drop shadow to it. A 
drop shadow is not a plug-in floater but 
rather an item in the Effects menu.

To add a drop shadow to your headline:

1In the Objects: Floater List palette, 
choose the Fractal Travel floater.

2Choose Effects menu> Objects> 
Create Drop Shadow. The Drop 
Shadow dialog appears.

3Leave all settings in their defaults and 
click OK.

Notice that the Floater List now reads 
Fractal Travel and Shadow instead of 
just Fractal Travel. The shadow is 
actually another floater grouped with the 
original. 

4To see both layers in the list, click the 
arrow icon to the left of the floater name.

5Choose the Shadow floater.

The Drop Shadow dialog.
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6Use the arrow keys to shift the shadow 
down and to the left so it looks as though 
the type is hovering above the 
parchment. 

Using Bevel World
In this last exercise, you will create a 
button like one you’d use on a Web page. 
To do so, you’ll use the Bevel World 
feature, new in Painter 5. 

To use Bevel World:

1In the Floater Portfolio, click the 
Passport floater and drag it anywhere 
onto the poster.

2Choose the Adjuster tool from the Tools 
palette.

Add a drop shadow to the headline.
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3Choose Effects menu> Orientation> 
Free Transform.

4Resize the floater to your liking. When 
you are finished transforming, choose 
Effects menu> Orientation> Commit 

Transform.

5With the Passport floater still selected, 
choose Bevel World from the Plug-in 
Floater Library pop-up and click Apply. 

6Adjust the sliders and settings to your 
liking.

7When you are finished click OK.

The Bevel World dialog appears.
Finishing this Lesson
Your travel poster is now complete and 
should look similar to the one shown here.

Use Bevel World to create a button out of a 
floater and finish the poster.
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